Autodesk 3ds Max FBX Plug-in (2010.2)

User Guide
## Contents

### Chapter 1 3ds Max FBX Plug-in What’s New

- What’s new in this version ................................................................. 1
  - Selection Sets support ................................................................. 2
  - TurboSmooth ............................................................................... 2
  - Composite maps ........................................................................... 2
  - Display Layer Support ................................................................ 2
  - Enhanced Hardware shader support .......................................... 2
  - Biped merge-back workflow enhancements ................................ 2
  - Normal Bump Map Support .......................................................... 3
  - MAXScript export selected functionality ..................................... 3
  - Use scene name ............................................................................ 3
  - Generate log data ......................................................................... 3
  - Tangents and Binormals support .................................................. 4
- Known limitations for this version .................................................. 4
  - Environmental texture maps ......................................................... 4
  - Standard material map channel values ......................................... 4
  - Morph information ......................................................................... 4
  - Locked Ambient and Diffuse channels .......................................... 4
  - Photometric lights ......................................................................... 4
  - Export issue .................................................................................. 4
  - Biped layers .................................................................................. 5
  - Shapes and NURBS ....................................................................... 5
  - TCB interpolation controllers ....................................................... 5
  - Scale compensation ..................................................................... 5
  - Bitmaps, procedural, and map channels ....................................... 6
- Conversion support .......................................................................... 6
  - Camera support ............................................................................ 6
  - Light support ................................................................................ 7
  - Custom properties/attributes ...................................................... 8

### Chapter 2 Installing the 3ds Max FBX Plug-in

- Windows installation ......................................................................... 11
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 3 FBX Plug-in UI</td>
<td>15</td>
</tr>
<tr>
<td>Basic UI options</td>
<td>15</td>
</tr>
<tr>
<td>Storing presets</td>
<td>17</td>
</tr>
<tr>
<td>Creating a custom preset</td>
<td>17</td>
</tr>
<tr>
<td>Editing a preset</td>
<td>17</td>
</tr>
<tr>
<td>Edit mode options</td>
<td>18</td>
</tr>
<tr>
<td>Chapter 4 Exportv</td>
<td>21</td>
</tr>
<tr>
<td>Exporting from 3ds Max to an FBX file</td>
<td>21</td>
</tr>
<tr>
<td>Export presets</td>
<td>22</td>
</tr>
<tr>
<td>Autodesk Media &amp; Entertainment preset</td>
<td>23</td>
</tr>
<tr>
<td>Edit/Save preset</td>
<td>24</td>
</tr>
<tr>
<td>Include</td>
<td>24</td>
</tr>
<tr>
<td>Geometry</td>
<td>25</td>
</tr>
<tr>
<td>Split per-vertex Normals</td>
<td>25</td>
</tr>
<tr>
<td>Tangents and Binormals</td>
<td>26</td>
</tr>
<tr>
<td>TurboSmooth</td>
<td>26</td>
</tr>
<tr>
<td>Selection Sets</td>
<td>27</td>
</tr>
<tr>
<td>Convert deforming dummies to Bones</td>
<td>27</td>
</tr>
<tr>
<td>Display Layers</td>
<td>27</td>
</tr>
<tr>
<td>Smoothing Groups</td>
<td>28</td>
</tr>
<tr>
<td>Animation</td>
<td>28</td>
</tr>
<tr>
<td>Extra options</td>
<td>28</td>
</tr>
<tr>
<td>Bake animation</td>
<td>28</td>
</tr>
<tr>
<td>Deformations</td>
<td>29</td>
</tr>
<tr>
<td>Curve filters</td>
<td>29</td>
</tr>
<tr>
<td>Point cache file(s)</td>
<td>32</td>
</tr>
<tr>
<td>Cameras</td>
<td>33</td>
</tr>
<tr>
<td>Lights</td>
<td>33</td>
</tr>
<tr>
<td>Embed media</td>
<td>33</td>
</tr>
<tr>
<td>Advanced options</td>
<td>35</td>
</tr>
<tr>
<td>Units</td>
<td>35</td>
</tr>
<tr>
<td>Scale Factor</td>
<td>35</td>
</tr>
<tr>
<td>Scene units converted to:</td>
<td>35</td>
</tr>
<tr>
<td>Axis conversion</td>
<td>36</td>
</tr>
<tr>
<td>UI</td>
<td>36</td>
</tr>
<tr>
<td>Show/Hide Warning Manager</td>
<td>37</td>
</tr>
<tr>
<td>Generate log data</td>
<td>37</td>
</tr>
<tr>
<td>FBX file format</td>
<td>38</td>
</tr>
<tr>
<td>Type</td>
<td>38</td>
</tr>
<tr>
<td>FBX version</td>
<td>38</td>
</tr>
<tr>
<td>Collada</td>
<td>39</td>
</tr>
<tr>
<td>Chapter 5 Import</td>
<td>41</td>
</tr>
<tr>
<td>Importing FBX files into 3ds Max</td>
<td>41</td>
</tr>
<tr>
<td>Import presets</td>
<td>42</td>
</tr>
<tr>
<td>Autodesk Media &amp; Entertainment preset</td>
<td>43</td>
</tr>
<tr>
<td>Autodesk Architectural (Revit) preset</td>
<td>43</td>
</tr>
<tr>
<td>Edit/Save preset</td>
<td>44</td>
</tr>
<tr>
<td>Statistics</td>
<td>44</td>
</tr>
<tr>
<td>Include</td>
<td>46</td>
</tr>
<tr>
<td>Geometry</td>
<td>46</td>
</tr>
<tr>
<td>Smoothing groups</td>
<td>46</td>
</tr>
<tr>
<td>Display Layers</td>
<td>46</td>
</tr>
<tr>
<td>Animation</td>
<td>47</td>
</tr>
</tbody>
</table>
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>3ds Max FBX Plug-in Workflows</th>
<th>59</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Revit Architecture to 3ds Max workflow</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td>Importing faceted geometry</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>Large file sizes</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>Removing visible edges from imported FBX models</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Workflow limitations</td>
<td>63</td>
</tr>
<tr>
<td></td>
<td>IFFFS</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>Preserving turned Edges in 3ds Max</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Unwanted scaling in 3ds Max</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>MotionBuilder and Maya scaling</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Revit scaling</td>
<td>68</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Scripting for the 3ds Max FBX Plug-in</th>
<th>71</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Loading the FBX plug-ins</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Loading the 3ds Max FBX Plug-in manually</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Loading the 3ds Max FBX Plug-in using MAXScript</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Scripting commands</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>FBXExporterGetParam [arg]</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>FBXExporterSetParam [arg] [value]</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>FBXImporterGetParam [arg]</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>FBXImporterSetParam [arg] [value]</td>
<td>75</td>
</tr>
</tbody>
</table>

| Chapter | 3ds Max FBX Plug-in glossary | 79 |

| Index | 83 |
The following section contains the new features and known limitations for the 2010 versions of the 3ds Max FBX Plug-in.

**NOTE** Consult the readme file for any last-minute changes to this release. Find the readme, along with this Help system, in the Program Files > Autodesk FBX folder.

### What’s new in this version

This section lists the new features included with the 2010 versions of the 3ds Max FBX Plug-in. Click the hyperlinks below to see more details.

**New features**

This version of the 3ds Max FBX Plug-in includes the following enhancements:

- Selection Sets support on page 2
- TurboSmooth on page 2
- Composite maps on page 2
- Display Layer Support on page 2
- Biped merge-back workflow enhancements on page 2
- Normal Bump Map Support on page 3
- Added MAXScript export selected functionality on page 3
- Added a Use scene name on page 3 option.
- Added a Generate log data on page 3 option.
- Tangents and Binormals support on page 4
Selection Sets support

The 3ds Max FBX Plug-in now supports the export and import of Selection Sets.

A Selection Set option has been added to the FBX Exporter, but no option is needed for the FBX Importer as all selection sets in the file are imported automatically. See Selection Sets on page 27.

TurboSmooth

A new option has been added to the 3ds Max FBX Exporter to support the default export of the source mesh (non-tessellated version) and TurboSmooth attributes. See TurboSmooth on page 26 for more information.

NOTE The TurboSmooth export option applies only to objects that have an active TurboSmooth modifier applied.

Composite maps

The 3ds Max FBX Plug-in now supports the export and import of Composite Maps. This improves interoperability between Autodesk 3ds Max, Mudbox, and Maya.

Display Layer Support

The 3ds Max FBX Plug-in now supports the automatic export and import of Display Layers. This improves interoperability between Autodesk Maya, Mudbox, and 3ds Max. See Display Layers on page 27 for more information and limitations.

Enhanced Hardware shader support

This version of the 3ds Max FBX Plug-in contains HLSL hardware shader enhancements. These enhancements include the ability to modify shader settings within 3ds Max and export to FBX with the changes intact. This functionality now lets you export customized HLSL hardware shaders to FBX while maintaining visual fidelity.

Biped merge-back workflow enhancements

3ds Max 2010 and 3ds Max Design 2010 now made changes that dramatically improve the Biped to FBX Merge-Back workflow.

What is the Biped Merge-Back workflow?

3ds Max users can use the 3ds Max FBX Plug-in to export Biped data to the FBX file format for import into Autodesk MotionBuilder. They can use this process to animate their Bipeds using MotionBuilder tools.

The following is the Biped Merge Back workflow:

1. Create your Biped in 3ds Max and export to FBX.
2. In MotionBuilder, import the FBX file, animate; then Plot (re-sample) the animation onto the character skeleton.
3. Save the scene as an FBX file.
4. Copy MotionBuilder animation data from the saved FBX file onto the original Biped character in 3ds Max using the FBX importer Update scene elements on page 52 feature.
Performance enhancements

Previously, Biped merge-back operations were time-consuming but enhancements have been made to the 2010 release of 3ds Max that greatly improve the speed of the merge-back process.

This table shows some of the dramatic test results that reflect the improvements made to this merge-back operation:

<table>
<thead>
<tr>
<th>3ds Max 2009 FBX Import</th>
<th>3ds Max 2010 FBX Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>55 seconds</td>
<td>02 seconds</td>
</tr>
<tr>
<td>40 seconds</td>
<td>01 second</td>
</tr>
<tr>
<td>4 hours</td>
<td>18 seconds</td>
</tr>
</tbody>
</table>

Precision enhancements

In previous releases of 3ds Max, when users merged MotionBuilder animation onto 3ds Max Bipeds, several knee and elbow joints precision issues would occur. For example, elbow and knee joints would pop out of place on a few select frames only to pop back into place a few frames later. The result was an incorrect conversion of animation, and could render the workflow unusable. In 3ds Max 2010, these precision issues have been addressed.

Normal Bump Map Support

The 3ds Max FBX Plug-in now supports Normal Bump Maps associated to materials in 3ds Max.

**NOTE** Only the Normal Bump Map’s Normal channel is supported. Images applied to the Additional Bump channel are ignored during export.

MAXScript export selected functionality

This version of the 3ds Max FBX Plug-in has a new MAXScript added to let you export selected elements to FBX without exporting all the related connections. See Export selected on page 75 for more detail.

Use scene name

The 3ds Max FBX Plug-in now lets you name exported scene animation using 3ds Max scene name. Normally, the 3ds Max FBX Plug-in saves 3ds Max scene animation in the FBX file as Take 001. See Use scene name on page 28 for more information.

Generate log data

You can now disable the generation of error log data if you do not want this information written to the log. This can be useful if you run batch imports(exports that create large warning/error files. See Generate log data on page 56.
**Tangents and Binormals support**

Activate this option if you want the 3ds Max FBX Plug-in to create tangents and binormals data from UV and Normal information of meshes. This way you can have a tangent space representation of your meshes that you can use for advanced rendering. See Tangents and Binormals on page 26 for more information.

**Known limitations for this version**

The following section contains a list of known limitations for this version of the 3ds Max FBX Plug-in:

**Environmental texture maps**

The 3ds Max FBX Plug-in does not support environmental texture maps (Environ option).

**Standard material map channel values**

The 3ds Max FBX Plug-in does not retain amount values for Standard material map channels, such as Diffuse and Specular level when exporting. The FBX format saves few of these values and sets all channels to a value of 100 on import.

The 3ds Max FBX Plug-in reads the glossiness and specularity amounts from shader basic parameters and not from the Maps rollout in the Material editor. The Bump map channel amount is retained.

**Morph information**

The 3ds Max FBX Plug-in does not export Morph information with Patch geometry.

**Locked Ambient and Diffuse channels**

The 3ds Max FBX Plug-in does not export 3ds Max Lock information from Ambient and Diffuse channels. If you define a texture in the Ambient channel when you import an FBX file into 3ds Max, the Ambient, and Diffuse channels become unlocked. To preserve the locked state of the channel, you must lock them after you import the scene.

**Photometric lights**

The plug-in converts Photometric lights to Standard lights.

**Export issue**

A limitation exists where objects exported with the FBX format remain in the last state shown in the Viewport. The plug-in exports any vertex animation on an object in its current PRS coordinates. For example, if you export a cylinder with a 100-frame animated Bend modifier at frame 50, the scene shows the cylinder at a 50-percent bend.
Workaround

To accommodate this limitation, position your Time slider at the point in the animation you want to export. To retain the entire animation, create a selection set for animated objects. Then, activate the Include > Animation > Point Cache File(s) option in the 3ds Max FBX Exporter window.

Biped layers

Animation that exists on multiple layers may not export.

The 3ds Max FBX Plug-in conditionally supports Biped animation layers. If you highlight a layer and export it with the Media & Entertainment default preset, you will only export the animation from that specific layer.

How can I export multi-layer animation?

As long as you are at the uppermost (top) layer, and use the Bake animation on page 28 option in the FBX exporter, you can export all animation from the top down on the layers that reside beneath the top layer.

If you do not activate Bake Animation, only the top layer of animation is exported. This is because the 3ds Max FBX Plug-in Bake Animation option scans through any unsupported controllers in 3ds Max and then re-samples the animation for export.

You can find the Bake Animation option in Include > Animation > Bake Animation.

NOTE  Alternatively, we recommend collapsing all your layers into one as a best practice.

Shapes and NURBS

When you enable Shapes and NURBS curves in the Viewport, the Shapes export as editable meshes, and the NURBS curves export as NURBS surfaces. For example, if you had a circle shape enabled in the Viewport, the circle would become capped on export.

TCB interpolation controllers

For improved interoperability, keyframe animation set on controllers with TCB interpolation or tangent slopes set to Fast, Slow, or User resamples systematically.

Scale compensation

If you modify the scale of joints that are parents of other joints in Maya, they do not import correctly into 3ds Max. This import problem occurs because 3ds Max does not support scale compensate settings in Maya.

What does Scale Compensate do?

If you scale a parent joint in Maya using scale compensation, it creates an offset for the child joint rather than scaling it.

But if you do the same thing in 3ds Max, the child scales and creates no offsets.

Since 3ds Max does not support Scale Compensate, any joint hierarchy you use in Maya with scale compensate looks wrong in 3ds Max.
When do I de-activate scale compensate so it imports correctly into 3ds Max?

Deactivate the scale compensate for joints only if you have modified the scale of any joints that are parents of other joints.

If all your joints are the same scale, you do not have to deactivate this setting in Maya.

To deactivate scale compensate in Maya:

1. In Maya, select the child joint.
2. In the Attribute Editor, deactivate the Segment Scale Compensate attribute.
   This option deactivates the scale compensation setting.

Bitmaps, procedural, and map channels

The 3ds Max FBX Plug-in processes any type of image map in almost any standard material channel. Anything that you map in the Diffuse, Specular and other channels translate to FBX, as long as they are not procedural maps.

The FBX plug-in can transfer bitmap image and Composite Layer maps. However, the FBX plug-in ignores files created with procedural mapping systems like Dent or Smoke as it does not currently support these mapping types.

<table>
<thead>
<tr>
<th>Map channel</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient</td>
<td>Supported</td>
</tr>
<tr>
<td>Diffuse</td>
<td>Supported</td>
</tr>
<tr>
<td>Specular color</td>
<td>Supported</td>
</tr>
<tr>
<td>Specular level</td>
<td>Supported</td>
</tr>
<tr>
<td>Glossiness</td>
<td>Supported</td>
</tr>
<tr>
<td>Self-Illumination</td>
<td>Supported</td>
</tr>
<tr>
<td>Opacity</td>
<td>Supported</td>
</tr>
<tr>
<td>Bump</td>
<td>Supported</td>
</tr>
<tr>
<td>Reflection</td>
<td>Supported</td>
</tr>
</tbody>
</table>

NOTE The FBX Plug-in ignores any maps applied to unsupported channels on export.

Conversion support

The following sections are about how the 3ds Max FBX Plug-in converts 3ds Max objects and their properties.

Camera support

The following tables indicate how both 3ds Max and the FBX file format treat cameras.
Camera export

The following table lists 3ds Max cameras and how the FBX file format treats them on export:

<table>
<thead>
<tr>
<th>In 3ds Max</th>
<th>Becomes in FBX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Camera</td>
<td>Camera without interest.</td>
</tr>
<tr>
<td>Target Camera</td>
<td>Camera with interest.</td>
</tr>
<tr>
<td>Roll Angle Animation</td>
<td>Roll FCurve. The plug-in inverts Angle values when exporting to FBX to maintain a consistent orientation.</td>
</tr>
<tr>
<td>Orthographic Camera</td>
<td>The Orthographic setting which you apply in 3ds Max to a free or target camera is retained in FBX.</td>
</tr>
<tr>
<td>FOV channels</td>
<td>Field of View FCurve. The view is consistent, even though the focal length values changes.</td>
</tr>
<tr>
<td>Width-related FOV</td>
<td>Horizontal Aperture.</td>
</tr>
<tr>
<td>Height-related FOV</td>
<td>Vertical Aperture.</td>
</tr>
<tr>
<td>Near and Far plane</td>
<td>Near and Far values if clipping is active. Since you cannot animate Near and Far values in MotionBuilder, it uses the current time value to evaluate the resulting Near and Far value.</td>
</tr>
</tbody>
</table>

**NOTE** The UpVector animation is plotted on the Roll FCurve. If not animated, the plug-in always exports it as (0,1,0). Camera Scale is not supported. The plug-in does not support Diagonal-Related Field Of View, and interprets its channels as a horizontal Field of View. Environment Planes are not supported. Target Distance is exported as a static value. If you animate the channel, the resulting value is the one evaluated at the current time.

Camera import

The following lists how 3ds Max treats MotionBuilder cameras on import:

<table>
<thead>
<tr>
<th>In FBX</th>
<th>Becomes in 3ds Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Camera</td>
<td>Free camera.</td>
</tr>
<tr>
<td>Camera (With a look-at Target/Interest)</td>
<td>Target camera.</td>
</tr>
<tr>
<td>Orthographic Camera</td>
<td>Orthographic camera</td>
</tr>
</tbody>
</table>

**NOTE** Since the Near and Far plane values for cameras in MotionBuilder are constant, you cannot animate the 3ds Max channel.

Light support

The following tables list 3ds Max lights and how the plug-in treats them on export to FBX and reimport to 3ds Max:
**Standard lights**

<table>
<thead>
<tr>
<th>In 3ds Max</th>
<th>When imported back into 3ds Max:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Omni</td>
<td>Omni</td>
</tr>
<tr>
<td>Free Directional</td>
<td>Free Directional</td>
</tr>
<tr>
<td>Target Directional</td>
<td>Free Directional</td>
</tr>
<tr>
<td>Free Spot</td>
<td>Free Spot</td>
</tr>
<tr>
<td>Target Spot</td>
<td>Target Spot</td>
</tr>
<tr>
<td>Skylight</td>
<td>Omni</td>
</tr>
<tr>
<td>mr Area Spot</td>
<td>Target Spot</td>
</tr>
<tr>
<td>mr Area Omni</td>
<td>Omni</td>
</tr>
</tbody>
</table>

**NOTE** In non-Revit to 3ds Max workflows, the 3ds Max FBX Plug-in does not support Skylights (and their targets). Instead the plug-in converts them to null objects. The plug-in also converts mr Lights to Standard lights (for example, an mr Area Omni light becomes a Standard Omni light) and Photometric lights become Standard lights (where they lose any Photometric-specific values).

**Photometric lights**

<table>
<thead>
<tr>
<th>In 3ds Max</th>
<th>When imported back into 3ds Max:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target light</td>
<td>Omni. The target is exported as a null.</td>
</tr>
<tr>
<td>Free light</td>
<td>Omni light</td>
</tr>
<tr>
<td>mr Sky Portal</td>
<td>Omni light</td>
</tr>
</tbody>
</table>

**Custom properties/attributes**

This section show custom properties and attributes and the status of their support in the 3ds Max FBX Plug-in.

**Custom attributes**

The following table lists 3ds Max custom attributes and whether they are supported when exported to the FBX file format.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle Spinner</td>
<td>Supported</td>
</tr>
<tr>
<td>Angle Slider</td>
<td>Supported</td>
</tr>
<tr>
<td>Array Dropdown List</td>
<td>Supported</td>
</tr>
<tr>
<td>Array Combo Box</td>
<td>Supported</td>
</tr>
<tr>
<td>Array List Box</td>
<td>Supported</td>
</tr>
<tr>
<td>Attribute</td>
<td>Support</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Boolean Check Box</td>
<td>Supported</td>
</tr>
<tr>
<td>Boolean Check Button</td>
<td>Supported</td>
</tr>
<tr>
<td>RGB Color Picker</td>
<td>Supported</td>
</tr>
<tr>
<td>Float Spinner</td>
<td>Supported</td>
</tr>
<tr>
<td>Float Slider</td>
<td>Supported</td>
</tr>
<tr>
<td>RGBA Color Picker</td>
<td>Supported</td>
</tr>
<tr>
<td>Integer Spinner</td>
<td>Supported</td>
</tr>
<tr>
<td>Integer Slider</td>
<td>Supported</td>
</tr>
<tr>
<td>Material Button</td>
<td>Not supported</td>
</tr>
<tr>
<td>Node Pick Button</td>
<td>Not supported</td>
</tr>
<tr>
<td>Percent Spinner</td>
<td>Supported</td>
</tr>
<tr>
<td>Percent Slider</td>
<td>Supported</td>
</tr>
<tr>
<td>String</td>
<td>Supported</td>
</tr>
<tr>
<td>Texture Map Button</td>
<td>Not supported</td>
</tr>
<tr>
<td>World Units Spinner</td>
<td>Supported</td>
</tr>
<tr>
<td>World Units Slider</td>
<td>Supported</td>
</tr>
</tbody>
</table>

**User-defined properties**

The FBX file format supports 3ds Max user-defined properties. They are stored in the FBX file as custom properties and labeled as UDP3DSMAX.
Installing the 3ds Max FBX Plug-in

The 3ds Max FBX Plug-in is used by 3ds Max® to import, export, and convert files using the FBX file format. This chapter describes how to install the 3ds Max FBX Plug-in for Windows® XP (32/64-bit) and Windows® Vista (32/64-bit).

The 3ds Max FBX Plug-in comes with 3ds Max and is installed automatically. This procedure is included so you can upgrade your 3ds Max FBX Plug-in with later versions.

**NOTE** The 3ds Max FBX Plug-in that accompanies your version of 3ds Max may not be the most recent version. It is a good practice to check for updates, as each subsequent 3ds Max FBX Plug-in version has enhanced functionality, and is available free. See [Web updates](#) on page 15 for instructions on how to verify that your plug-in version is the latest.

**NOTE** The 3ds Max FBX Plug-in runs only on the version of 3ds Max for which it is created. Verify that the 3ds Max FBX Plug-in you are installing is appropriate for your version of 3ds Max, and that you are using the latest plug-in version. Otherwise 3ds Max rejects it. See [Downloading the 3ds Max FBX plug-in](#) on page 13.

Windows installation

The 3ds Max FBX Plug-in is available for Windows.

**Windows compatibility**

The 3ds Max FBX Plug-in is compatible with the following versions of Microsoft Windows:

- Windows XP (32/64-bit)
- Windows Vista (32/64-bit)

**To install the 3ds Max FBX Plug-in:**

1. Exit 3ds Max.

**NOTE** If you install the 3ds Max FBX Plug-in while 3ds Max is operating, the installation cannot occur. You will receive an “Error opening file for writing” message.
NOTE If you have previously installed older versions of the FBX Plug-ins, you may need to remove these plug-in files manually. These files are removed automatically during the installation process, but if you receive an error or warning when you run the plug-in, check for older versions of the plug-in files and remove them manually. To do so, search and delete the following files: fbxmaxexp.dle and fbxmaximp.dli.

The current 3ds Max FBX Plug-in is named fbxmax.dlu and must be the only installed version of the 3ds Max FBX Plug-in.

2 Download the install file from the Autodesk web site http://www.autodesk.com/fbx. See Downloading the 3ds Max FBX plug-in on page 13 for information on downloading the latest 3ds Max FBX Plug-in.

3 Double-click the install file to launch the Autodesk 3ds Max FBX Plug-in installer.

4 Click I accept to accept the terms of the license agreement, and then click Next.

5 The next window shows the recommended installation location for the plug-in. To specify another location, click Browse to launch the file browser.
6 Click Next.

7 The next window shows the recommended installation location for the plug-in documentation. To specify another location, click Browse to launch the file browser.

8 Click Install.

9 A series of dialog boxes appear asking if you would like to keep older versions of the plug-in (if applicable), open the plug-in documentation or view the read me file. Select Yes or No for each of these options.

10 The Installation completed window appears. Click Close to exit the installer.

The 3ds Max FBX Plug-in is now installed.

**Downloading the 3ds Max FBX Plug-in**

The 3ds Max FBX Plug-in is available for free download.
NOTE: The 3ds Max FBX Plug-in that accompanies your version of 3ds Max may not be the most recent version. It is a good practice to check for updates, as each subsequent 3ds Max FBX Plug-in version has enhanced functionality, and is available free. See Web updates on page 15 for instructions on how to verify that your plug-in version is the latest.

To download the 3ds Max FBX Plug-in:

2. Click the Download FBX Plug-ins and Tools link for the latest SDK and FBX plug-ins releases.
3. Click the FBX Plug-ins, Converter, and QuickTime Viewer downloads link.
   You are taken to a page where the plug-ins reside.

   **NOTE**: The FBX plug-ins are categorized by type, operating system, then application version.

4. Click the FBX Plug-in link to download the corresponding FBX Installer.

   **NOTE**: To find older versions of the FBX Plug-ins, click the Plug-in and Converter Archives link at the bottom of the web page.

Checking your FBX version number

Once you complete the installation, run the 3ds Max FBX Plug-in. The header of the FBX Exporter and Importer windows in 3ds Max displays the FBX Version number.

The 3ds Max FBX Plug-in that accompanies your version of 3ds Max may not be the most recent version. It is a good practice to check for updates, as each subsequent 3ds Max FBX Plug-in version has enhanced functionality, and is available free. See Web updates on page 15 for instructions on how to verify that your plug-in version is the latest.
This section describes the 3ds Max FBX Plug-in user interface. Options and menus are contained within rollout menus that you can expand and collapse.

Basic UI options

The buttons in this section are common to the 3ds Max FBX Plug-in user interface (UI) and are available whenever the UI is displayed.

Help

Click the Help icon to access the 3ds Max FBX Plug-in documentation.

Web updates

Click the Web Updates button to make sure that you are using the latest version of the 3ds Max FBX Plug-in. This function searches the Autodesk web site to check if there is a newer version of the plug-in that you are currently using.
If you have the latest version, the following message appears:

If a newer version of the 3ds Max FBX Plug-in exists, a window appears to inform you.

See Downloading the 3ds Max FBX plug-in on page 13 for information on downloading and installing the latest 3ds Max FBX Plug-in.

**Edit**

You can use the Edit preset button to create and save custom presets with option settings that you define.
Access the Edit/Save preset options through the Edit button in the FBX plug-in UI.

The 3ds Max FBX Plug-in stores custom presets in a file so you can share them with other users. See Storing presets on page 17 for more information.

See Editing a preset on page 17 for information about how to create custom presets.

Ok

The OK button starts the export or import process.

Cancel

The Cancel button closes the FBX Export or Import window without performing any action.

Storing presets

You can save your custom presets in a file that you can share with other users. Consult the table for the location of your saved presets.

<table>
<thead>
<tr>
<th>FBX Version</th>
<th>Preset location</th>
</tr>
</thead>
<tbody>
<tr>
<td>2009.4 (and earlier)</td>
<td>C:\My Documents\3dsmax\FbxPresets</td>
</tr>
<tr>
<td>2010.0 (and later)</td>
<td>C:\My Documents\3dsmax\FBX\Presets</td>
</tr>
</tbody>
</table>

Preset files have the file extension .fbximportpreset, for example My Preset.fbximportpreset.

Creating a custom preset

You can create your own preset with options specific to the kind of Import or Export you want to perform. You can also modify existing presets with custom option settings and UI layouts using the Edit preset mode. See Editing a preset on page 17.

To create a custom preset

1. Configure the FBX importer or exporter with the settings and UI layout you want.
2. Click Edit > Save preset.
3. Type the name of the new preset for example, “My preset”.
4. Click OK. For information about changing your custom preset, See Editing a preset on page 17.

Editing a preset

You can modify existing presets with custom option settings and UI layouts using the Edit preset mode.

1. Click Edit > Edit preset.
2. A dialog box opens to inform you that you must right-click a tree view item to edit its parameters. Click Ok.
3 This action splits the UI into two sections, and adds a tree view of the FBX options in the left section.

4 Right-click elements in the Tree View to access the Edit options.

NOTE Some edit options are common to all structure levels, while some are specific to a particular structure level. You can apply some options at any level of the options structure. See Edit mode options on page 18.

**Edit mode options**

Use the Edit Mode options to customize your FBX UI preset.

**Show/Hide**

This option activates or disables the visibility of a group or option in the UI.
Enable/Disable
This option locks the group or option so that it appears grayed-out in the UI and cannot be modified.

Expand/Collapse
This option lets you change whether the group or option is shown expanded or collapsed by default in the UI.

View as expandable group/View as expanded Panel
This option lets you set whether a group is expandable or not.
Exporting from 3ds Max to an FBX file

To export your 3ds Max scene:

1. In 3ds Max, select Application Menu > Export from the main menu bar. A file browser appears. Browse to the location where you want to save the FBX file.

2. Name the file and select Autodesk (.FBX) in the Save as Type field.

3. Click Save. The FBX Exporter window opens.
If you want, select a preset from the Presets menu. The Autodesk Media and Entertainment preset contains the best balance of options for a general animation workflow. See Autodesk Media & Entertainment preset on page 23 for more information.

You can also select your own options for export from the FBX Exporter window. For more information about export options and which are appropriate for you, review the Exportgv on page 21 section.

Click Ok. If conversions or errors occur during the export process, the Warning Manager reports them at the end of the process. See Show/Hide Warning Manager on page 37 for information about the Warning Manager.

NOTE There is a difference between “Errors” vs. “Warnings”. The plug-in reports an error when something unexpected occurs. When the plug-in reports an error, it indicates that the consequences of that error are unknown. Warnings inform users when the plug-in applies conversions to the source data to convert the data into a format that the destination application can read.

Export presets

The 3ds Max FBX Plug-in has one export workflow preset:

- Autodesk Media & Entertainment preset on page 23

Autodesk Media and Entertainment is the default preset for the 3ds Max Exporter.

Selecting a preset

Choose your preset by selecting it in the menu of the FBX Plug-in “Presets” section.
Editing presets

If you change a preset, the preset field displays User defined, to show that the preset differs from its default state. The plug-in saves the User defined state in a temporary file so that the settings are the default the next time you use the plug-in.

You can also use Edit > Save preset to save your settings as a custom preset. See Creating a custom preset on page 17 and Editing a preset on page 17.

Autodesk Media & Entertainment preset

The Autodesk Media and Entertainment preset contains the most options since it contains the optimal settings for most animation workflows.
Edit/Save preset

You can use the Edit preset button to create and save custom presets with option that you define.

Access the Edit/Save preset options with the Edit button in the FBX Exporter UI.

The 3ds Max FBX Plug-in stores custom presets in a file so you can share them with other users. For more information, see Storing presets on page 17.

For more about creating and editing presets, see Creating a custom preset on page 17 and Editing a preset on page 17.

Include

The Include rollout lets you decide what data and conversions the plug-in applies to your scene at export from a host application.
**Geometry**

Expand the Geometry rollout to access options related to exporting geometry from your scene.

**Split per-vertex Normals**

Activate this option in order to split geometry vertex Normals based on edge continuity.

This option only applies to MotionBuilder workflows to ensure visual fidelity of surface continuity. It lets you transfer hard edge information to MotionBuilder. This transfer is required because of a MotionBuilder limitation.

Do not use this option if you do not require hard edges in MotionBuilder, since this operation duplicates vertex information and converts geometry.

**When do I use this?**

Use this option to preserve whether edges are hard (divided) or not (continuous) when you operate between 3ds Max or Maya and MotionBuilder. If you disable this option, all smoothing groups in 3ds Max are ignored as well as all hard/soft edge information in Maya.

For example, a 3ds Max-created box that would normally have defined edges would lose them, with all faces visually connected, without visible edges dividing them, in MotionBuilder. This is result is hardly noticeable for organic objects, but is very noticeable on hard surfaces such as tables and cars, and so on.

See the Split per-vertex workflow to import FBX files exported from 3ds Max into MotionBuilder with proper edge continuity while retaining the original 3ds Max edge continuity for import back into 3ds Max.

**Split per-vertex normals workflow:**

1. Export from 3ds Max with the Split per-vertex Normals option activated.
2. Import your scene in MotionBuilder using FBX File Import, finalize your animation and click Save to resave the FBX file.
3. In 3ds Max, import the FBX file with your original 3ds Max scene open. Choose Include > File content > Update scene elements to import/update only the animation in the scene.
Split per-vertex Normals option disabled on export produces this result in MotionBuilder.

Split per-vertex Normals option activated on export produces this result in MotionBuilder.

Tangents and Binormals

Activate this option if you want the 3ds Max FBX Plug-in to create tangents and binormals data from UV and Normal information of meshes. This way you have a tangent space representation of your meshes that you can use for advanced rendering.

**NOTE** Your geometry must have UV information, or the 3ds Max FBX Plug-in cannot create tangents and binormals.

**Why do I want to do this?**

Exporting tangent and binormal data is useful when you need to define the local coordinate system for each vertex in the mesh, which is referred to as “Tangent space”. This is often required for advanced rendering techniques such as normal mapping.

The 3ds Max FBX Plug-in reads the UV data and uses it to calculate the Tangent space data for normal perturbation in per-pixel lighting.

**TurboSmooth**

Use TurboSmooth to export the source mesh (non-tessellated version) and the TurboSmooth attributes, for objects with an active TurboSmooth modifier applied.

If you disable this option, the tessellated version of the mesh is exported. To export the source mesh, turn off the TurboSmooth modifier in 3ds Max, and export.
**Selection Sets**

Objects and all Editable Poly/Mesh & Poly/Mesh Select modifier sub-object (component) selection sets are supported for export and import with the 3ds Max FBX Plug-in.

Activate this option to export Selection sets. Disable this option if you do not want Selection Sets exported with your file. This option is disabled by default.

**NOTE** To avoid name clashing, Sub-object Named Selection sets are renamed on export. For example, if you had a Sub-object Named selection set of one vertex called “OneVertex” that belonged to Box01, on export it becomes renamed “Box01_OneVertex_Vertex”.

**When should I not do this?**

Activating this option includes extra data with your scene so be certain that you need the Selection set data before you export. Exporting a scene with Selection Sets impacts file size and if Selection Sets are not required, it is good practice to keep the file size as small as possible by excluding unwanted data.

**Convert deforming dummies to Bones**

Activate this option to convert geometry used for deforming objects into real bones in the FBX file.

3ds Max lets you use geometry to deform other geometry (as would bones), but other applications do not support this kind of deformation.

**Why do I need this?**

Use this option to keep deformations but convert geometry used as bones into actual bone objects.

In earlier versions of Maya, you could not use geometry to deform other objects instead of bones. This option lets users import objects from other software that had a Use Geometry as Bone option, such as 3ds Max and Softimage into Maya.

For example, if you had a scene in 3ds Max where a box was used to deform another box, the geometry as bone object became a proper bone object in Maya if the Convert Geometry used as Bones option was active. If you disabled this option, the box would remain a box and there would be no animation.

Maya now supports this type of deformation, so it is no longer necessary to activate this option. However, it is still a best practice to leave this option activated for improved interoperability as not all products support geometry as bones.

**Display Layers**

The 3ds Max FBX Plug-in automatically exports Display layers and does not appear as an option in the 3ds Max FBX Plug-in user interface.

**NOTE** Layer properties are only supported by layers that are not layer 0; the 3ds Max FBX Plug-in does not recognize layer 0. For example, if you have objects in Layer 0 and Layer 1, the 3ds Max FBX Plug-in ignores the Layer 0 properties but retains the layer property information for Layer 1.

**The following 3ds Max Display Layer properties are exported:**

- Layer Member List
- Layer Names
- Display as Box
Freeze Attribute
Hide
Color

**Smoothing Groups**

Activate this option when you want to include Smoothing Group information in your exported FBX scenes. This option is disabled by default in the Autodesk Media & Entertainment preset.

*NOTE* When you disable this option, only explicit normals are exported with the file.

**Animation**

Activate this option to export animation found in the scene.
Expand this option to access advanced animation options and features.

**Extra options**

Expand Extra options to view addition export options.

**Use scene name**

Normally, the 3ds Max FBX Plug-in saves the 3ds Max scene animation in the FBX file as Take 001. If you want the scene animation to instead be named after the 3ds Max scene, activate this option.
This option is deactivated by default.

**Bake animation**

This option lets you Bake (or Plot) animation at export time.
When you activate this option all unsupported constraints and controllers, including the 3ds Max Biped, are resampled into animation curves. You can then import these curves into another application that does not support these 3ds Max constraints.

The plug-in takes the Start and Stop values automatically from the “timeline” current settings of the host application. You can modify them by changing the values once you activate this option.

The Step value defines how many keys are created per frame, and has a value of 1 by default. Setting a Step of 2 for example, only bakes and exports a key every other frame.

*NOTE* The FBX Exporter will bake animation on any objects that have keys on both FBX-supported and unsupported Transform (Position, Rotation, and Scale) controllers.
Deformations

Activate the Deformations option to export Skin and Morph deformations. You can choose to export Skins and Morphs specifically by expanding Deformations to access individual options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Morphs</td>
<td>Activate this option to export all geometry Morphs used in your scene.</td>
</tr>
<tr>
<td>Skins</td>
<td>Activate this option to export all Skin deformations used in your scene.</td>
</tr>
</tbody>
</table>

Curve filters

The Curve filters let you apply animation filters to function curves during the export process.

Constant key reducer

Activate the Constant Key Reducer filter to remove redundant keys. Redundant keys are keys that have the same value, which are equivalent to flat horizontal interpolations on a curve. Redundant keys are often a result of a resampled curve.

Before:

After:

You can set specific thresholds for each type of transform (Transformation, Rotation, Scaling, and Other. Other includes Morph and custom attribute curves, for example).

The default values are:
Values represent generic units. This is why you might need to modify threshold values in relation to the world scale of your scene. This is true for very large or small scale scenes.

If keys are numerically identical, use very small values to ensure that no animation is lost.

If you use this filter to eliminate noise, for example, from motion capture data, then you might need to modify values.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation Precision</td>
<td>Threshold for Translation curves in generic units.</td>
</tr>
<tr>
<td>Rotation Precision</td>
<td>Threshold for Rotation curves in generic units.</td>
</tr>
<tr>
<td>Scaling Precision</td>
<td>Threshold for Scaling curves in generic units.</td>
</tr>
<tr>
<td>Other Precision</td>
<td>Threshold for other curves in generic units.</td>
</tr>
<tr>
<td>Auto tangents only</td>
<td>This option ensures that only “auto” key types are filtered. Otherwise, keys with interpolation values greater than a certain threshold might be deleted.</td>
</tr>
</tbody>
</table>

### Unroll rotations

Activate the Unroll Rotations filter to resample rotation curves and give unroll priority and filter intensity to a specific component, X, Y, or Z.

This filter re-evaluates rotation curves to reduce the number of 180° degree rotation jumps for a specified component. You can modify or displace these rotation jumps and/or Gimbal Lock with this filter, and not affect the resulting animation visually.

Before:

![Before](image1)

After:

![After](image2)
NOTE The Unroll Rotations filter must resample the entire vector of a rotation curve (X, Y & Z components). This resampling lets the plug-in find a new path of values that represent the same rotation.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Precision</td>
<td>The precision value affects how the plug-in re-evaluates the curve and defines the importance given to the unrolled curve.</td>
</tr>
<tr>
<td>Follow Y-up</td>
<td>Activate this option to give priority to the Y component, normally used for Y-up scenes.</td>
</tr>
</tbody>
</table>

**Key Reducer**

Activate the Key Reducer filter to reduce the number of keys on animation curves by setting tangents in order to keep precision of the animation.

You also can use this filter to reduce the number of keys on resampled curves, which lets you edit keys, not dense data.

Before:

![Before](image1)

After:

![After](image2)
There is always a trade-off between the number of keys needed versus the precision of the animation. The more keys you have, the more precise the animation. The fewer keys you have, the easier it is to edit the keys, but there is less precision.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter intensity</td>
<td>Generic value. A value of &quot;1&quot; keeps the filter intensity of the original visual result, in most cases.</td>
</tr>
<tr>
<td>XYZ Curve Synchronization</td>
<td>On X, Y, Z curves, this option adds keys to other curves (X, Y, or Z) at every added key. This setting increases the number of keys. It also ensures that they always exist on all three curves of the same vector (X, Y, and Z) for each key over time.</td>
</tr>
</tbody>
</table>

NOTE: Game engines often require this for real-time animation playback.

The default values for the Key reducer filter are a precision value of 1.0 and the XYZ Curve Synchronization option disabled.

Point cache file(s)

Activate this option to create a cache file of a chosen selection set so you can retain vertex animation data during export. To use this option, you must first create a selection set of the objects for which you want to retain the vertex animation in 3ds Max. Use the Selection Set menu to select an appropriate set to export the cache file.

The stored vertex animation data is stored in a folder in the same location as the FBX file.

NOTE: You must place the folder wherever the FBX file is placed, so that when an importer processes the FBX file, it will find the point cache data.

What is vertex animation?

Object animation occurs when you move a sphere from one place to another. If you rotate or scale this object, it is still considered object animation; Any TRS animation on the object is considered standard object animation and is what is kept on regular exports.

Vertex animation occurs at the sub-object (vertex) level. For example, if you were to move 4 vertices on a sphere, this animation is lost on export unless you create a point cache file for this animation.

What is a Point cache?

A Point cache is a local sub-object animation of an object. To export this local sub-object animation from a program like 3ds Max, every vertex position must be evaluated and stored in a file or series of files called point cache files. You must make a selection set of the object(s) for which you want the vertex animation evaluated.

In 3ds Max, you create a point cache for your object(s) so you can have better playback for complex animating. If, for example, you had a scene with 20 controllers driving the animation of 500 different characters, creating...
a point cache file would let you store all the vertex animation and play it back on all 500 characters, so that 3ds Max does not evaluate the animation controllers for each character. This in turn, creates a more smooth playback.

**By default, any point cache files created are in .MC format. When you activate this option, three files are generated:**

- an FBX file
- an XML file
- an MC file

The 3ds Max FBX Plug-in stores the XML and MC files in a subfolder named after the FBX file and has the extension FPC (_fpc).

For example, if you export a scene containing a cube named box01 to the FBX file myTest.fbx, you create the following files and folders:

- myTest.fbx
- myTest_fpc
- box01.xml
- box01.mc

The plug-in keeps any PC2 or MC point cache files that are already recorded (within the selection set).

**Cameras**

Activate this option to export all cameras contained in the scene.

The plug-in exports camera settings, but not render settings. Activating the Cameras option can change rendering results depending on the source application used in comparison. When you export, 3ds Max cameras are converted into FBX camera types for interoperability. The plug-in supports camera settings and converts them, but does not save render settings associated to the camera with the file.

**Lights**

Activate this option to export all lights contained in the file. The 3ds Max FBX Plug-in exports and converts light types to ensure FBX interoperability.

The 3ds Max FBX Plug-in supports Standard Point, Spot and Directional light types exported to FBX for Autodesk Maya, Autodesk MotionBuilder, and other Autodesk applications. For a list of supported lights, see Light support on page 7.

**Embed media**

Activate this option to include (or embed) all media associated with your scene in the FBX file itself. For example, texture images.

When you activate “Embed Media”, the FBX plug-in includes (embeds) associated media (textures, for example) within the FBX file. The plug-in then extracts the media to an .fbm folder at import. The plug-in copies the embedded media to a <fileName>.fbm folder in the same location as the FBX file and is named after the FBX file. Since this media is contained within the FBX file itself, this has an impact on file size.
Therefore, it is good practice to use this option only when you transport an FBX file to a location where the original media source is no longer accessible by the receiver.

**What if I do not do this?**

If you disable the Embed Media option, the FBX plug-in stores the relative and absolute paths of the associated media files at export time. This causes problems if, for some reason, the path is no longer accessible. Make sure that the associated media is accessible to ensure the proper import of these media files.

If you export a file to FBX and do not activate the Embed Media option, no problems occur if you open the file on the same computer and all the images used in the scene are in the same locations that they were when the file was exported. However, if you move or delete any texture from that location, and use the FBX file afterwards, you will get an Importer message stating that you have missing texture files. This message also appears if you give this FBX file to someone using a different computer and who does not have that same texture in that same directory on the same computer drive.

It is a good practice to embed media when you are going to give the FBX file to another person. It is also a good practice to embed when you use FBX for storing assets, as you may eventually delete the reference images or move all the files to another drive or computer with different paths.

**NOTE** If you export your file in ASCII format, you cannot embed textures.

**Convert images to portable format (TIFF).**

Activate this option to convert your non-TIFF-formatted texture images into TIFF format which are supported by most DCC applications. Converting images to TIFF format makes them readable in other applications that do not support your image type. This also lets the FBX Importer convert an image without losing any data.

**Why convert images?**

When the FBX Importer uses a TIFF format map, it searches for an available format type and uses TIFF when there is nothing compatible. For example, if you exported a BMP file from 3ds Max with this option activated, the file is converted to TIFF and stored in the FBX file. If you then imported the file into software that did not support BMP images, the TIFF file would remain a TIFF. If the software did support BMP files, the TIFF file is converted back to a BMP file.

If the destination application supports the image type, the plug-in does not apply the TIFF conversion, even if you activated this option at export time. This behavior is determined by what the destination application supports, and the conversion only occurs if needed.
Advanced options

The Advanced Options section primarily contains additional options that let you modify the default plug-in behavior. In most cases you do not need to modify these options to have a successful export. The section also holds additional settings specific to the Collada file type.

Units

The Units option lets you view the conversion factor (Scaling value) the plug-in uses as well as modify the conversion units.

NOTE This does not change the System Units in 3ds Max.

Scale Factor

Displays the conversion value or Scale Factor that the plug-in applies to the entire scene during export.

By default, the 3ds Max FBX Plug-in uses the system units set in the host application to determine what units to use to export the FBX file. This means that the default export Scale Factor is always 1.0, and the plug-in applies no unit scale conversion during the export process.

You can modify what units the 3ds Max FBX Plug-in uses to export your scene if you change the Scene units converted to option. If you change the Scene units converted to option, you modify the Scale Factor value and units applied to the exported data.

For information about incorrect or unwanted scaling issues, see Unwanted scaling in 3ds Max on page 67.

NOTE If you change the “Scene units converted to” option, you will modify the Scale Factor value and units applied to the exported data.

Scene units converted to:

Use this menu to specify the units to which you want to convert your exported scene. Modifying this setting directly affects the Scale Factor value applied to the exported data.
The plug-in determines the default units by looking at the System Unit Scale in the System Unit Setup dialog box in 3ds Max.

**NOTE** To view the default units, click System Unit Setup in the Units Setup dialog box that appears when you select Units Setup from the 3ds Max Customize menu.

In the FBX UI, the displayed Scale Factor uses the FBX Unit setting for its calculation. The plug-in determines the FBX Unit setting from the host application's system units.

On export, the plug-in applies no default scaling since the export and system units match. This results in a Scale factor of “1.0”.

For information about incorrect or unwanted scaling issues, see Unwanted scaling in 3ds Max on page 67.

**Example**

If you export a file that is in the same Unit setting as the System Units of your 3ds Max scene, there is a match of units and the displayed Scale Factor will be “1.0”. No scale conversion is applied.

**Axis conversion**

The FBX export plug-ins have two options for Axis Conversion, Y-up, or Z-up.
When you use the Autodesk Media & Entertainment preset, the 3ds Max FBX Plug-in exports using the Z-Up Axis.

You can export your scene to a Y-up axis if the destination application does not support the Z-up world axis and cannot convert the Z-up world axis of your scene.

**NOTE** The exporter applies Axis Conversions only to root elements of the outgoing scene. If you have animation on a root object that must be converted on export, these animation curves are resampled to apply the proper axis conversion. To avoid resampling of these animation curves, make sure to add a Root Node (dummy object) as a parent of the animated object in your scene, before you export to FBX.

**UI**

These options let you set display options of the UI, such as show or hide the Warning Manager.

You can customize these display options, save them as a new Preset, and share this preset file. See the Edit/Save preset on page 24 section for more information.

**Show/Hide Warning Manager**

This option lets you disable the Warnings and Errors dialog box that appear during the export process. The Warning Manager is active by default.

**What is the difference between an Error and a Warning?**

The 3ds Max FBX Plug-in uses errors and warnings to alert you of conversions and potential problems during the export process.

When something unexpected occurs during the conversion, the plug-in reports an error. An error occurs when the plug-in encounters an unknown behavior and the conversion is going to produce an unexpected result.

When the plug-in must apply a conversion to the source data for it to be in a format that the Destination application can read, the plug-in reports a warning. This warning is not the indication of a problem, but is there to provide a report of conversions that the plug-in has applied to the outgoing data.

**Generate log data**

Deactivate the Generate log data option if you do not want warning and error information written to the log. However, if you deactivate this option, the FBX Exporter/Importer records the file name and time stamp in the log file, but does not include error and warning data.

The 3ds Max FBX Plug-in stores log files with the FBX presets, in C:\My Documents\3dsmax\FBX\Logs.

**Why do I want to do this?**

Occasionally, some batch imports/exports create very large warning/error files, and in this case you might want to disable this option.

Normally, it is recommended to leave the Generate log data option active, which is the default, as this helps you identify problems with file conversions.
Log files are important for tracking errors and warnings on export. It is not recommended to deactivate this option when you export a series of files, for example, in an automation or batch export because you will not receive any feedback about any issues that concern files during export. This lack of feedback can make it difficult to identify problem files which, in turn, makes diagnosing problems difficult.

**TIP** Because log data is appended to the same log file, after a while the size of this file become large. It is a good practice to delete the log file after a few exports, or before processing batch export or import.

## FBX file format

This section lets you determine the format of your FBX file.

### Type

Save your FBX file as one of these two types, Binary or ASCII. While binary is the normal format for FBX files, ASCII files give you a plain text version of the file format, which lets you search the file for information retrieval.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>Activate this option to save the FBX file in the standard format.</td>
</tr>
<tr>
<td>ASCII</td>
<td>Activate this option to save the FBX file in ASCII format.</td>
</tr>
</tbody>
</table>

**NOTE** If you export your file in ASCII format, no textures are embedded.

### FBX version

Expand the FBX Version menu to select an FBX version.

The following table lists the different versions available for you to select from the FBX exporter option.

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FBX2010</td>
<td>Select this FBX version to export a file that is compatible with the latest FBX 2010 version of the 3ds Max FBX Plug-in. This is the default FBX version.</td>
</tr>
<tr>
<td>FBX200900</td>
<td>Select this FBX version to export a file that is compatible with the FBX 2009 versions of the FBX Plug-ins.</td>
</tr>
<tr>
<td>FBX200611</td>
<td>Select this FBX version to export a file that is compatible with the FBX 200611 version of the FBX Plug-ins.</td>
</tr>
<tr>
<td>FBX200608</td>
<td>Select this FBX version to export a file that is compatible with the FBX 200608 version of the FBX Plug-ins.</td>
</tr>
<tr>
<td>Version</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FBX200602_MB75</td>
<td>Select this FBX version to export a file that is compatible with the FBX200602 version of the FBX Plug-ins. This includes older versions of MotionBuilder. NOTE This is no longer necessary with the most recent versions of MotionBuilder, since “Fbx Plug-in Import” has been implemented.</td>
</tr>
<tr>
<td>FBX200508_MB70</td>
<td>Select this FBX version to export a file that is compatible with the FBX200508 versions of the FBX Plug-ins. This includes older versions of MotionBuilder.</td>
</tr>
<tr>
<td>FBX60_MB60</td>
<td>Select this FBX version to export a file that is compatible with the FBX60 versions of the FBX Plug-ins. This includes older versions of MotionBuilder.</td>
</tr>
</tbody>
</table>

**When do I use this?**

You do not need to change this option if you are using the latest FBX 2010 Plug-ins in the source and destination applications. This option is only for exporting older versions of the FBX plug-ins, not the application, unless the latest plug-in is not available for that specific version.

For example, if you want to export from 3ds Max 2010 and import to 3ds Max 2008 using the latest FBX 2010 versions of the plug-ins in both applications, you do not need to change the export FBX version. The file is compatible when you use the FBX 2010 versions of the plug-in.

**Collada**

The Collada options only appear when you select the Collada (.DAE) file type from the file browser when you export.

**NOTE** When you export to Collada you are not able to embed textures, even if the Embed media option is activated. See **Embed media** on page 33. This is because exporting to COLLADA results in an ASCII-format file, which does not allow binary information, such as textures, and so on.
**Triangulate**

This option automatically tessellates the exported polygon geometry.

**Single matrix**

This option ensures that there is only a single animation matrix for each node/object by baking all animation matrices into one.

**Frame Rate**

Use this field to set the frame rate of the scene on export.

---

**NOTE**  The 3ds Max FBX Plug-in does not support Lines or Linestrip nodes.
Importing FBX files into 3ds Max

This section describes how to import files using the 3ds Max FBX plug-in:

To import an FBX file:

1. Launch 3ds Max.
2. Select Application Menu > Import, and use the file browser to locate the FBX file you want to import.

   **NOTE** If you do not see FBX file extension the File of Type menu, it did not correctly install or is not the correct version. Check that you have the correct version of the 3ds Max FBX Plug-in and reinstall it. Do not run 3ds Max while you install the plug-in. See Web updates on page 15 for information on how to verify your plug-in version.

3. The FBX Importer window opens. Set the import options you want.
Click Ok.

If conversions or errors occur during the import process, the Warning Manager reports them at the end of the import process. See Show/Hide Warning Manager on page 56 for information about the Warning Manager.

NOTE There is a difference between "Errors" vs. "Warnings". The plug-in reports an error when something unexpected occurs. When the plug-in reports an error, it indicates that the consequences of that error are unknown. Warnings inform users when the plug-in applies conversions to the source data to convert the data into a format that the Destination application can read.

Import presets

The 3ds Max FBX Plug-in includes two import workflow presets:

■ Autodesk Media and Entertainment
■ Autodesk Architectural (Revit)

The default preset is based on the application version you are using. If you use 3ds Max, Autodesk Media and Entertainment is the default preset. If you use 3ds Max Design, Autodesk Architectural (Revit) is the default preset.

Selecting a preset

You can choose your preset by selecting it in the menu of the FBX Plug-in "Presets" section.
Editing presets

If you change a preset, the preset field displays User defined, to show that the preset differs from its default state. You can find the User defined states in a temporary file so that the settings are the default the next time you use the plug-in.

You can also use Edit > Save preset to save your settings as a custom preset. See Creating a custom preset on page 17 and Editing a preset on page 17.

Autodesk Media & Entertainment preset

The Autodesk Media and Entertainment preset contains the most options since it contains the optimal settings for most animation workflows. All available options are visible in the UI so you can access and customize them.

Autodesk Architectural (Revit) preset

The Autodesk Architectural (Revit) preset is a simplified version of the FBX UI. It has optimal settings for architectural workflows translating data from the Autodesk Revit application, to Autodesk 3ds Max Design. The preset exposes no options, only the Preset, and Statistics sections. This preset contains all the basic
settings necessary for a Revit to 3ds Max workflow, but you can edit the preset so that it contains any other settings you require. See Edit/Save preset on page 44.

In this preset, Animation on page 47 options are disabled, the Smoothing groups on page 46 option is disabled and the File content on page 52 option is set to Add to scene.

**Edit/Save preset**

You can use the Edit preset button to create and save custom presets with option settings that you define.

Access the Edit/Save preset options through the Edit button in the FBX Importer UI.

The 3ds Max FBX Plug-in stores custom presets in a file so you can share them with other users. For more information, see Storing presets on page 17.

For more about creating and editing presets, see Creating a custom preset on page 17 and Editing a preset on page 17.

**Statistics**

The Statistics window lets you view relevant Meta information about the incoming (FBX) file and system (application) settings. Information varies depending on what is in the file.
**File name**
Displays the name of the file.

**File directory**
Displays the location of the file directory.

**File version**
Displays the FBX version of the file.

**File creator**
Displays the name and version of the application that created the file.

**File creation time**
Displays the date and time that the file was created.

**File axis direction**
Displays the up-axis of the file.

**File units**
Displays the unit of measurement in the file.

**System axis direction**
Displays what the up-axis is in the current application.

**System units**
Displays the unit of measurement used in the current application.

**File content**
Displays the number of Elements, Textures, Materials, and Caches in the file.
The Include rollout lets you choose what data and conversions to apply to your scene when you import from a host application.

Geometry

Expand the Geometry rollout to access options related to importing geometry into your scene.

Smoothing groups

Activate this option when you want to retain the Smoothing Group information in the imported FBX file. When the FBX file contains no smoothing group data and this option is activated, the plug-in re-evaluates the geometry and creates Smoothing Groups for all imported geometry based on the explicit normals data. Activating this option directly affects performance. This performance loss occurs because the plug-in must re-evaluate all the geometry.

NOTE You can use this option when you import Revit-exported or MotionBuilder-saved FBX scenes, as they contain no Smoothing Group information, but some smoothing groups may not generate properly, and could potentially cause shading inconsistencies.

This option is disabled by default in the Autodesk Media & Entertainment preset on page 43. It is also disabled in the Autodesk Architectural (Revit) preset on page 43.

If the FBX scene already contains smoothing group data and this option is disabled, the 3ds Max FBX Plug-in imports only explicit normals data (and ignores all smoothing group information).
When do I use this?

Activating this option is ideal for 3ds Max users who import scenes intending to use and modify Smoothing Groups information.

NOTE If your scene contains thousands of objects and you know that you do not want to work with Smoothing Groups, do not use this option. Otherwise the 3ds Max FBX Plug-in must re-evaluate every object during import, which is time consuming.

If you are a Maya user, the plug-in already exports smoothing information (Hard/Soft edges). Activating this option usually gives the same visual results as disabling the option. The difference is the additional Smoothing Group information/IDs (for example, faces identified as belonging to smoothing group 1, 2, and so on).

Example

For example, if you want to edit the smoothing of objects that come from Revit, activate this option to create Smoothing Groups when you import. You can then edit these Smoothing Groups in 3ds Max.

Since Revit has no smoothing group data to export, the 3ds Max FBX Plug-in importer must create it. Similarly, Maya also does not export smoothing group data by default. Maya uses Hard/Soft edge information that it directly applies to geometry normals, unless you activate the Maya FBX Exporter Plug-in Smoothing Group option, and then Smoothing Groups are generated from Hard/Soft edge information.

Display Layers

The 3ds Max FBX Plug-in automatically imports Display layers and does not appear in the 3ds Max FBX Plug-in user interface. When an FBX file contains display layers, it imports objects with their Object Properties set to “By Layer”.

NOTE Layer properties are only supported by layers that are not layer 0; FBX does not recognize layer 0. For example, if you have objects in Layer 0 and Layer 1, FBX ignores the Layer 0 properties but retains the layer property information for Layer 1.

The following Display Layer properties are imported:

- Layer Member List
- Layer Names
- Display as Box
- Freeze Attribute
- Hide
- Color

Animation

Activate this option to import animation found in the scene.
Expand this option to access advanced animation options and features.

Deformations

Activate the Deformations option to import Skin and Morph deformations.
You can choose to import Skins and Morphs specifically by expanding Deformations to access individual options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Morphs</td>
<td>Activate this option to import all geometry Morphs contained in the incoming file.</td>
</tr>
<tr>
<td>Skins</td>
<td>Activate this option to import all Skin deformations contained in the incoming file.</td>
</tr>
</tbody>
</table>

**Animation Take**

Displays the current animation take in the FBX file.

If no animation take exists in the file, the field shows a “No animation” message.

If several animation takes exist in the file, the currently selected take is displayed in the field.

You can change the selected take of animation by choosing another take from the menu. The plug-in lists all available takes of animation contained in the file.

**NOTE** You can only select and import a single take of animation at a time.

**Bake animation layers**

Bake animation layers lets you bake (or Plot) animation layers contained in the incoming file.

If your incoming file contains animation layers, make sure that this option is activated so that the plug-in considers all animation curves. This process bakes all layers to the base layer and makes them compatible with 3ds Max Curve editor. This option is active by default.

If you disable this option, the plug-in imports only the Base (or first) layer of animation and ignores all additional layers.

If there are no additional animation layers in the file, you can leave this option active with no effect.

**Optical markers**

Activate this option to convert Optical Markers contained in the file into dummy objects on import.

If you disable this option, the import process ignores this data.

Optical Markers normally come from motion capture data, as a cloud of animated points or markers. The plug-in does not import the animation as the data type is incompatible. However, the plug-in converts optical data into a cloud of static Dummy objects in 3ds Max.

**NOTE** If your optical data originates from MotionBuilder, you can set the state of all optical markers to “Done” in MotionBuilder. Setting the markers this way lets you import the animation data as curves in 3ds Max.

**Curve filters**

The Curve filters let you apply animation filters to function curves during the import process.
Constant key reducer

Activate the Constant Key Reducer filter to remove redundant keys. Redundant keys are keys that have the same value, which are equivalent to flat horizontal interpolations on a curve. Redundant keys are often a result of a resampled curve.

Before:

![Before Image]

After:

![After Image]

You can set specific thresholds for each type of transform. T, R, S, and Other. Other includes Morph and custom attribute curves, for example.

Values represent generic units. This is why you might need to modify threshold values in relation to the world scale of your scene, for example with extremely large or small scale scenes.

If keys are numerically identical, use very small values to ensure that no animation is lost.

If you use this filter to eliminate noise, for example, from motion capture data, then you might need to modify values.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation filter intensity</td>
<td>Threshold for Translation curves in generic units.</td>
</tr>
<tr>
<td>Rotation filter intensity</td>
<td>Threshold for Rotation curves in generic units.</td>
</tr>
<tr>
<td>Scaling filter intensity</td>
<td>Threshold for Scaling curves in generic units.</td>
</tr>
<tr>
<td>Other filter intensity</td>
<td>Threshold for other curves in generic units.</td>
</tr>
<tr>
<td>Auto tangents only</td>
<td>This option ensures that the plug-in filters only “auto” key types. Otherwise, keys with interpolation values greater than a certain threshold might be deleted.</td>
</tr>
</tbody>
</table>

The default values are:
Key Reducer

Activate the Key Reducer filter to reduce the number of keys on animation curves by setting tangents to keep the animation precision.

You can also use this filter to reduce the number of keys on resampled curves, which lets you edit keys, not dense data.

Before:

After:

NOTE There is always a trade-off between the number of keys needed versus the precision of the animation. The more keys you have, the more precise the animation. The fewer keys you have, the easier it is to edit the keys, but the precision is lost.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter intensity</td>
<td>Generic value. A value of “1” keeps the precision of the original visual result, in most cases.</td>
</tr>
<tr>
<td>XYZ Curve Synchronization</td>
<td>On X, Y, Z curves, this option adds keys to other curves (X,Y, or Z) at every added key. The Curve Synchronization setting increases the number of keys, but ensures that they always exist on all three curves of the same vector (X, Y, and Z) for each key over time. Note: Game engines often require this for real-time animation playback.</td>
</tr>
</tbody>
</table>

Default values are:
**Point cache file(s)**

Activate this option to import FBX-exported point cache data during the FBX import process.

The plug-in generates three files when you export Point Cache Files using FBX:

- an FBX file
- an XML file
- an MC file

The plug-in stores XML and MC files in a subfolder named after the FBX file and has the extension FPC (_fpc).

For example, if you export a scene containing a cube named Box01 to the FBX file myTest.fbx, you create the following files:

- myTest.fbx
- myTest_fpc
- Box01.xml
- Box01.mc

**Bones**

Expand Bones to customize the creation of 3ds Max bones.

Use the Bones option to choose if you want to create “real” 3ds Max bones or dummy objects that behave the same way that 3ds Max bones do. This way you get better visual results.

You can also use this option to create bone objects that are a specific size. The plug-in only uses these values on rare occasions when the plug-in does not compute bone size automatically.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock width and height</td>
<td>Locks the values entered in the Width and Height field. (This setting is active only if you enter the same value in the Bone Width and Height fields.)</td>
</tr>
<tr>
<td>Convert as Dummy OR Leave as Bones</td>
<td>Select Convert as Dummy to convert joints or bones into Dummy objects on import. They resemble bones but do not have the limitations of a “real” 3ds Max bone. Select Leave as Bones to convert joints or bones into “real” or true 3ds Max Bones.</td>
</tr>
<tr>
<td>Width</td>
<td>The size of the bone width. (This setting only affects how the bone looks and does not affect how it behaves.)</td>
</tr>
</tbody>
</table>
### Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>The size of the bone height. (This setting only affects how the bone looks and does not affect how it behaves.)</td>
</tr>
<tr>
<td>Taper</td>
<td>The percentage of the Width or Height (or thickness) applied to the end or the tip of the bone.</td>
</tr>
</tbody>
</table>

### File content

Use the File content menu to select how to import the content of your file into the host application. Select from the following three options: Add and update scene elements, Update scene elements, and Add to scene.

**Add and update scene elements**

This option adds the content of the FBX file to your scene and updates existing elements.

Use this option to add non-existing elements to the scene, and replace the animation of elements that are already present in the host application. Select this setting to combine the effects of the Add to scene and Update scene elements options.

This is the default setting for the Autodesk Media & Entertainment preset.

**Update scene elements**

This option updates existing elements of your scene.

Use this option to update (exclusive merge) elements that already exist in the host application. Update scene elements does not create new elements in the host application.

**Add to scene**

This option adds all content of the FBX file to the host application. If elements exist in the host application, they are duplicated.

This is the default setting for the Autodesk Architectural (Revit) preset.

### Cameras

Activate this option to import all cameras contained in the file.

The plug-in imports camera settings, but not render settings. This can change rendering results depending on the source application used in comparison.

Cameras are saved as FBX types in the FBX files for interoperability. This means they must convert into 3ds Max camera types on import.

### Lights

Activate this option to import all lights contained in the file.

FBX supports Standard Point, Spot, and Directional light types from Autodesk Maya, Autodesk MotionBuilder, and other Autodesk applications.
Photometric light types coming from the Autodesk Revit 2009 (and later) application into Autodesk 3ds Max Design 2009 (and later) application are currently supported.

Advanced options

Use the Advanced Options to customize your general settings and import process.

Units

The Units option lets you view the conversion factor (Scaling value) the plug-in uses as well as modify the conversion units.

This option automatically identifies, sets, and converts units of the incoming file to match units of the host application.

If this option is active, but the file units match the system units, there is no need for scale conversion and the plug-in applies no conversion. The displayed Scale Factor is 1.0 in this case.

NOTE This conversion affects only incoming data. This does not change the settings in 3ds Max.

For information about incorrect or unwanted scaling issues, see Unwanted scaling in 3ds Max on page 67.

Scale Factor

Displays the conversion value or Scale Factor that the plug-in applies to the entire incoming scene.

The plug-in compares the units used in the host application with the units used in the file imported to determine the Scale Factor value. The plug-in then proposes a unit conversion that matches the system units in the host application. The displayed Scale Factor is the result of this calculation.

This option is always active, but if your file units match the system units, the plug-in does not need to apply a scale conversion. The plug-in applies no conversion. The displayed Scale Factor is 1.0 in this case. You can enhance import speed and performance when your units match, especially in Revit to 3ds Max workflows.

NOTE If you change the File Units Converted to option, you can modify the Scale Factor value applied to incoming data.

For information about incorrect or unwanted scaling issues, see Unwanted scaling in 3ds Max on page 67.
**File units converted to:**

Use this menu to specify the units to which you want to convert the file. Modifying this setting directly affects the Scale Factor value applied to the incoming data.

The plug-in determines the default units by looking at the System Unit Scale in the System Unit Setup dialog box in 3ds Max.

**NOTE** To view the default units, click System Units Setup in the Units Setup dialog box that appears when you select Units Setup from the Customize menu.

The displayed Scale Factor uses this unit setting for its calculation.

This automatic behavior ensures that the plug-in respects the Units, and proper scaling is applied by default.

**NOTE** Verify the System Units your 3ds Max scene uses so that you can control whether the plug-in needs to scale your scene. See Unwanted scaling in 3ds Max on page 67 for information about the System Units setup in 3ds Max.

### Example

If you import a file that is in the same Unit setting as the System Units of your 3ds Max scene, there is a match of units and the displayed Scale Factor will be “1.0”. No scale conversion is applied.

If the units do not match and your 3ds Max scene is empty and/or changing the System Units is not a concern, change the 3ds Max System Units to match the File Units used in the incoming file before you start to import. This results in a match of units, Scale Factor of “1.0”, and no scale conversion is applied.
If, for example, you import a file that is in centimeters into a 3ds Max scene set to inches, with a resulting Scale Factor of 0.3937008. In this case, the incoming data will be scaled down to match the scene's unit system.

**NOTE** If the scale factor is 1.0, no scaling is applied. If the scale factor is greater than 1.0, the incoming data is scaled up. If the factor is smaller than 1.0, the incoming data is scaled down.

If, with the previous example, you do not want to change the System Units of your 3ds Max scene and do not want the plug-in to scale your incoming data, you have another option:

Change the File Units Converted To option to match the File Units. This results in a Scale Factor of “1.0”, and no scaling is applied, even though units do not match between the file and the 3ds Max System Units.

**NOTE** 3ds Max System and Display units are discussed in depth in *Unwanted scaling in 3ds Max* on page 67.

**Axis conversion**

The FBX importer does not have an Axis Conversion option in the UI. Only exporters have this option exposed in the UI. This is because the 3ds Max FBX Plug-in calculates and applies the Axis Conversion automatically upon import.
What does the automatic axis conversion do?

The importer looks at the up-axis used in the host application. In 3ds Max, this is always Z-up. It then compares this to the up-axis set in the incoming file. If both up-axes match, the importer applies no conversion. If they do not match, the importer applies a conversion to the imported data to match the host application’s up-axis automatically.

When the up-axes do not match, it creates a longer import process, because the 3ds Max FBX Plug-in must rotate each root object 90 degrees to match the host application up-axis. This is especially true of Maya or MotionBuilder to 3ds Max workflows.

NOTE The importer applies Axis Conversions only to root elements of the incoming scene. If you have animation on a root object that must be converted on import, these animation curves are resampled to apply the proper axis conversion. To avoid resampling of these animation curves, make sure to add a root node (Dummy object) as a parent of the animated object in the source scene (source application) before you export to FBX.

UI

These options let you set display options of the UI. This lets you Show or Hide the Warning Manager and FBX UI windows.

You can customize these display options, save them as a new Preset, and share this preset file. See the Edit/Save preset on page 44 section for more information.

Show/Hide Warning Manager

This option lets you disable the Warnings and Errors dialog box that appear during the import process. The Warning Manager is active by default.

What is the difference between an Error and a Warning?

The 3ds Max FBX Plug-in uses errors and warnings to alert you of conversions and potential problems during the import process.

When something unexpected occurs during the conversion, the plug-in reports an error. This error occurs because the plug-in encounters an unknown behavior and the conversion is going to produce an unexpected result.

When the plug-in must apply a conversion to the source data for it to be in a format that the Destination application can read, a warning is reported. This warning is not the indication of a problem, but instead exists to provide a report of conversions that have been applied to the incoming data.

Generate log data

Deactivate the Generate log data option if you do not want warning and error information written to the log. However, if you do deactivate this option, the FBX Exporter/Importer does not write log data (such as errors and warnings,) to the generated log file. However, the file name and time stamp are still recorded in the log.

The 3ds Max FBX Plug-in stores log files with the FBX presets, in C:\My Documents\3dsmax\FBX\Logs.

Why do I want to do this?

Occasionally, some batch imports/exports create very large warning/error files, and in this case you might want to disable this option.
Normally, it is recommended to leave the Generate log data option active, which is the default, as this helps you identify problems with file conversions.

Log files are important for tracking errors and warnings on import. It is not recommended to deactivate this option when you import a series of files, for example, in an automation or batch import because you will not receive any feedback about any issues that concern files during import. This lack of feedback can make it difficult to identify problem files which, in turn, makes diagnosing problems difficult.

**TIP** Because log data is appended to the same log file, after a while the size of this file become large. It is a good practice to delete the log file after a few exports, or before processing batch export or import.
3ds Max FBX Plug-in
Workflows

Because you can use 3ds Max FBX Plug-in for so many purposes, it is difficult to come up with instructions that explain every situation.

However, here are a few of the more commonly used workflows:

Revit Architecture to 3ds Max workflow

When you complete the initial design, layout, and modeling of a project in Revit Architecture, you can use Autodesk® 3ds Max® or Autodesk® 3ds Max® Design to produce high-end renderings and add final details.

- 3ds Max is a 3D animation package that provides animation, modeling, and workflow functionality for complex problems in design visualization and visual effects.

- 3ds Max Design is a 3D design visualization solution for architects, engineers, designers, and visualization specialists. Designed for interoperability with FBX® files from Revit Architecture, 3ds Max Design preserves model geometry, lights, materials, camera settings, and other metadata from Revit projects. With Revit Architecture and 3ds Max Design working together, designers can extend the building information modeling process to include design visualization.

NOTE For simplicity, the following topics refer to 3ds Max Design, but this information applies to 3ds Max as well.

You can export a 3D view from a Revit project to an FBX file and import it into 3ds Max. You can then create enhanced renderings of the design to share with clients in 3ds Max.

The FBX file format passes rendering information to 3ds Max, including lights, render appearances, sky settings, and material assignments for the 3D view. By preserving this information during the export process, Revit Architecture maintains a high degree of fidelity and reduces the amount of work required in 3ds Max.

Exporting to FBX from Revit Architecture

1. In Revit Architecture, open a 3D view, and prepare it for export.
2. Click File menu > Export > 3ds Max (FBX).

NOTE If this menu option displays as gray, open a 3D view of the project. Then try the menu option again.
3 On the Export dialog, for Save in, navigate to the target folder for the exported file.

4 For Naming, do one of the following:
   ■ To specify a file name manually, select Manual (Specify file name). For File name/prefix, specify the name of the output file.
   ■ To use an automatically generated file name, select Automatic – Long (Specify prefix), or Automatic – Short.

5 Click Save.

Revit Architecture generates the FBX file and saves it in the target location.

You can now import the FBX file into 3ds Max, using the 3ds Max FBX Plug-in.

**Importing your FBX file into 3ds Max Design**

You can download a high level document detailing FBX 3ds Max Design interoperability.

1 Follow the steps in Exporting to FBX from Revit Architecture on page 59.

2 In 3ds Max Design, Click File > Import, and select the FBX file you want to import, and Click OK.

3 In the 3ds Max FBX Plug-in, make sure that the Autodesk Architectural (Revit) preset on page 43 is the selected preset.

4 Click OK in the FBX UI window, and your FBX is imported.

**Importing faceted geometry**

If you see faceted geometry when you import Revit files into 3ds Max using 3ds Max FBX Plug-in, the Smoothing groups option might have been activated. Disable this option to correctly import Revit objects into 3ds Max.

Whenever you import a Revit file using FBX, deactivate the Re-evaluate Smoothing groups option. This option is now deactivated by default in the Autodesk Architectural Preset for all future releases of the 3ds Max FBX Plug-in. In the 2009.3 version of the 3ds Max FBX Plug-in, the Re-evaluate Smoothing Groups option was left activated in error.

The Smoothing groups re-evaluation process potentially slows down the import process, so your import process will speed up (depending upon file size) if you deactivate it. This increase in speed occurs because the importer no longer must evaluate every face in each of the geometries that already has a smoothing group associated with it and then, assigning one or more when required.

**Large file sizes**

Sometimes when you export a file from Revit, the file size dramatically increases. For example, a 30 mb Revit file can become 60 mb on export to FBX.

**Why does this happen?**

The original Revit file size is smaller because it contains less data than an FBX file. Revit scene file information accesses much scene information from libraries that reside within the Revit software, for example, Revit-specific construction data and textures. This information that is normally read from the Revit software now must be added on top of the FBX file on export so it can be reproduced accurately by software that cannot access Revit libraries.
This over-sizing problem also occurs with 3ds Max (.max) files on export for the same reason. A .max file must contain only the instructions that 3ds Max requires to create the scene. Materials and lighting information is read directly from the 3ds Max software libraries.

On top of this, when the Revit or 3ds Max file becomes an FBX file, it is converted to complex FBX scene information based on geometric data, such as vertex coordinates, UVs, and so on. This way, the FBX file contains the actual geometric data so it can be read in any software that supports the FBX format.

File sizes also tend to grow between Revit and FBX because all material data is embedded with the FBX file. The growth in file size means FBX files must contain every Revit texture used as materials so you can later import the FBX file into 3ds Max. A Revit scene file does not need to contain any texture files because the textures reside in the Revit software, where the scene file can refer to them.

Occasionally, large files do not import properly into 3ds Max due to memory constraints. If a file contains a massive amount of metadata and geometry, the import process can take hours.

**Working with large files**

There is also a known issue that affects few users when an extremely large FBX file is imported.

If you switch the 3ds Max System (not Display,) units to feet, so they match the Revit Imperial units exported to FBX, the import process takes much less time to complete. The unit conversion process is a complicated one for the FBX Importer and takes a long time to complete. Matching the units between an FBX file and the host program is often the deciding factor whether or not a large FBX file imports successfully into 3ds Max.

For more about System units conversion problems, see [Unwanted scaling in 3ds Max](#) on page 67.

**Removing visible edges from imported FBX models**

Use this script to hide any unwanted edges from imported models, typically Revit models loaded in 3ds Max using FBX.

**What are visible edges?**

The visible edges are hidden lines that are normally invisible in 3ds Max. The problem typically occurs with Revit models because everything exported from Revit is triangulated. This causes edges that 3ds Max would normally hide to become visible.

You can recognize a visible edge, for example, if you have a wall in Revit that should only be represented in 3ds Max with four edges which are the four sides of the wall. Instead, 3ds Max displays the middle triangle that connects both corner vertices. This middle triangle is normally hidden.

The following script reads all edges and determines which ones can be hidden by evaluating whether they are next to any neighboring edges. Hiding these unwanted edges makes the model much easier to view.

**To use this script:**

1. Select all objects in the scene.
2. Select MAXScript>New Script in the 3ds Max main menu.
3. Copy and paste the script below into the dialog.
4. Press CTRL-E to Evaluate All and run the script.

You can also save this script in 3ds Max and drag and drop the .ms file in the Viewport while objects are selected.

**NOTE** This script works only for editable meshes, and ignores editable polys, patches, or other entities.
-- do this in a local scope so I don't pollute the global scope.

function setVisibilityEdges obj =
{
    local edgeSelSet = #()
    -- Go through all faces
    local numFaces = obj.numfaces
    for faceIndex = 1 to numFaces do
        -- And for every one of the 3 edges
        for edgeIndex = 1 to 3 do
            -- collect the edge
            append edgeSelSet ( ((faceIndex-1)*3) + edgeIndex )
        end
    end
    -- Select all visible edges
    meshop.autoedge obj edgeSelSet 5 type:#setclear
}

--==============================================
-- Start of the runtime script
--==============================================

local timestart = timestamp()
-- turn off undo during this operation.
with undo off
{
    local editMeshArray = #()
    for obj in Selection do
        if (classof obj == Editable_Mesh) do
            -- collect all the edit meshes first, because the
            -- user could have selected some helper objects too, which we
            -- don't want to process.
            append editMeshArray obj
        end
    end
    -- we don't need to hold the selection anymore, clear it out.
    clearselection()
    -- Array of object handles that have already had their edges hidden
    local allReadyProcessed = #()
    -- iterate through all selected edit meshes...
    for editMeshobj in editMeshArray do
        local found = (FindItem allReadyProcessed editMeshobj.handle) > 0
        if (not found) then
            setVisibilityEdges editMeshobj
            append allReadyProcessed editMeshobj.handle -- Mark all the instances as processed too!
            for repeat in InstanceMgr.GetInstances editMeshobj &repeatArray do
                if (repeatArray.count > 0) then
                    -- mark them as processed by adding their handle to the array
                    for repeat in repeatArray do
                        --
                    end
                end
            end
        end
    end
}

--==============================================
Workflow limitations

Performance

Performance may be slow for large projects that contain many objects and data when exporting from Revit Architecture and importing into 3ds Max.

To improve performance, limit the model geometry you export. Try using a section box or hide categories of model elements that you do not need in Revit Architecture and set an appropriate level of detail level.

Cameras

- Multiple Cameras: Revit Architecture exports only one camera to FBX, which corresponds to the active 3D view. This means only the current Revit 3D view or camera, imports into 3ds Max as a 3D camera view.
- Camera Frame and Optical Center: The 3ds Max FBX Plug-in does not support the cropping region and optical center of Revit cameras. However, the field of view (FOV) or perspective of the Revit cameras is correct in 3ds Max. So, this does not translate precisely in 3ds Max if you modify your Revit camera by resizing and/or offsetting the cropping region (frame) of your 3D view in Revit. This is caused by a combination of FBX not transporting the render resolution settings, and a limitation that the 3ds Max camera model does not support an optical center.

Geometry

- Pivot point (object center): Geometry exported from Revit does not have a correct local pivot point or center, as is normal when you create objects in 3ds Max. Object centers are offset from the object, but have a correct position in global space. If you are not manipulating or animating the position of your objects in 3ds Max, this offset has no impact.
- Massing objects: Massing objects in Revit are not supported, and do not export to FBX.

Hidden Revit elements

In Revit, you can “hide” and “temporarily hide” elements. The FBX plug-in exports “temporarily hidden” objects from Revit. Although they exist, these elements are not visible in 3ds Max, since they are “hidden”. “Hidden” elements in Revit do not export and do not exist when you import your FBX into 3ds Max.

Groups

Revit Groups have no 3ds Max equivalent so the 3ds Max FBX Plug-in ignores all Revit Groups. For example, if you export lights within a Revit Light Group, the 3ds Max FBX Plug-in converts the lights but loses any grouping.
Project units

Revit calculates system units in Imperial units (Feet and fractional inches). When Metric units are set as the “Project Units”, Revit dynamically converts the Imperial units into Metric units, in the UI. This means that FBX always exports in the actual system units, Imperial (Feet). There are no issues in working with Metric units in Revit and 3ds Max, but this results in an Imperial (Feet) FBX file, that automatically converts to Metric (Meters) on FBX import into 3ds Max. When you use an Imperial (Feet) Project Unit in Revit and Feet System Units in 3ds Max, no conversion is needed.

For more on Revit units, see Unwanted scaling in 3ds Max on page 67.

Daylight Portals

Revit uses daylight portals differently from 3ds Max. They exist in both applications but because they are calculated differently at render time, 3ds Max FBX Plug-in does not import these daylight portals into 3ds Max. Doing so would result in low performance. This performance issue is because Revit systematically creates daylight portals for each individual window, and for each side of the window. This does not affect the rendering performance of Revit since only windows relevant to the camera view are only calculated at render time.

However, 3ds Max renders all daylight portals systematically. Therefore, it is better to create one single daylight portal for an entire wall of windows manually in 3ds Max as you would normally when you work in 3ds Max. This results in better performance and gives better visual results.

IFFFS

The following section is relevant for Autodesk Inferno, Autodesk Flint, Autodesk Flame, Autodesk Fire, and Autodesk Smoke (IFFFS) products.

Importing and Exporting Cameras.

You can either create or import a camera from an FBX file, then edit this 3D camera in IFFFS. You can then export this camera with animation to an FBX file so you can import this camera into a 3D application, such as 3ds Max, Maya, or MotionBuilder.

Flame Cameras

Flame supports the import and export of 3D data saved in the FBX format. The FBX format provides a way to exchange 3D data for scene compositions—such as cameras—between tools and packages developed by different manufacturers.

To export a camera to FBX format:

1 In Flame, select the camera you want to export.
2 In the Camera menu, click Export. The Export Camera file browser appears.
3 From the Export Type box, select FBX.
4 Select which elements of the FBX files you wish to export by clicking the corresponding filter button.

<table>
<thead>
<tr>
<th>Enable:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate Axis</td>
<td>Rotate the exported camera by -90° on the X-axis so that it is compatible with the coordinate system of the 3D application.</td>
</tr>
<tr>
<td>Export Axes</td>
<td>Export the animated axes present in the Action scene.</td>
</tr>
<tr>
<td>Enable:</td>
<td>To:</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export Point Cloud</td>
<td>Export the 3D-point cloud created by the 3D Tracker.</td>
</tr>
</tbody>
</table>

5  Navigate to the location where you want to export the FBX file.

6  Enter a name for your FBX file in the file field.

7  Click Save.

Preserving turned Edges in 3ds Max

The 3ds Max FBX Plug-in does not support the turning of hidden Edges on Editable polys.

What causes this?

Editable polys have hidden edges. When you look at a polygon in 3ds Max, the hidden Edge is invisible unless you turn on its Visibility. A hidden Edge with Visibility turned on appears as a dotted line when the Turn tool is activated. This gives the impression that the Editable poly model is composed of polygons when it is composed of triangles. The only difference is that the edges that complete the triangles are normally hidden from view.

You can turn hidden edges in editable poly and mesh objects to modify the shape of the hidden triangles within your polygons. This is a refining process useful if you want to modify how polygons are subdivided. Turning the edges lets you avoid thin triangles in your polygons, for instance. Turning hidden edges is a refining process some 3ds Max modelers go through as a last step.

To turn an Edge in 3ds Max:

1  Create a Plane primitive in 3ds Max.

2  Convert the Plane01 object to Editable Poly.

3  Go to the Polygon subobject level in the modifier stack and choose Edit Polygons > Turn.

4  Press F4 to show hidden edges in the viewport.

5  If you click any hidden edges you can see that the edges flip.

When you export this scene, hidden edge directions return to their default states.

Example

This following section illustrates what happens when Edges are turned.

In the following image, the Editable Poly hidden edge has been turned using the “Edit Triangulation” tool. The hidden edge on the Plane01 object is shown as a dotted line extending across from left to right. This scene is then exported to FBX.
The hidden edge is shown as a dotted line across the plane.

Once you import the exported FBX file into a new scene, the hidden edge changes direction from left to right. The Edge now reverts to the default top to bottom.

The Edge changes direction

The following image shows the effects this limitation has on editable poly objects with turned/modified hidden edges exported to FBX. Side to side vertices are pulled upward and the polygon cap follows the hidden edge.

A. What the imported object looks like when hidden edge turns are not retained. B. What the imported object looks like if hidden edge turns are retained.

Workaround

If you convert your Editable polys to Editable meshes, the triangulation stays intact. An Editable mesh is a truly triangulated object while an Editable poly is not. Since editable meshes are composed of triangles, the FBX import/export process retains them.
If you use a skin modifier, this workaround becomes more complex. But because editable polys and meshes contain the same amount of vertices, you can convert the poly to a mesh and still retain skinning. If so, do the following:

**To convert the poly to a mesh and still retain skinning:**

1. Cut the skin modifier.
2. Convert the object.
3. Paste the skin modifier back onto the converted modifier stack.

**Notes on polygon conversion**

Vertex colors are retained perfectly on conversion. However, the shading changes, since the triangulation of the object changes after you export it to FBX and import it to 3ds Max.

There is no data loss for vertex colors, however the VertexPaint modifier shaded mode displays the triangle coloring differently. This change is illustrated in the following image:

![A. Original B. After FBX Export/Import](image)

**Unwanted scaling in 3ds Max**

This topic addresses problems with unnecessary scaling of FBX files in 3ds Max.

3ds Max has two Unit settings, System and Display, that can create conflicts when you try to exchange data between 3ds Max and MotionBuilder, Maya, or Revit. If they are set differently (for example, inches and centimeters), the 3ds Max System and Display units settings do not create issues as long as you are only working within 3ds Max. However, MotionBuilder and Maya use centimeters, and Revit uses feet/meters, so conversions might occur each time an FBX file is moved between those programs.

Generally in 3ds Max, changing the System Unit Setup is discouraged as it can create confusion. But for the purposes of file exchange and interoperability, altering 3ds Max System units is necessary as FBX files do not take 3ds Max Display units into account. Consult the following sections for a detailed explanation of the scaling problem.

**MotionBuilder and Maya scaling**

Unlike 3ds Max, which uses inches as its base System unit, MotionBuilder and Maya both use centimeters. To compensate for this, 3ds Max users are generally instructed to switch their Display units to centimeters, and leave the default System units setting (inches) unchanged. This creates problems when exchanging files between other software applications.

For example, if you export a 3ds Max object when you have your Display units set to one measurement (such as centimeters), and your System units set to another measurement, the FBX exporter only considers the 3ds Max System units, even if they differ from the Display units.
This becomes more complex if you then save the FBX file in MotionBuilder and import it back into 3ds Max. The FBX Importer evaluates the 3ds Max System units, but once you save the FBX file in MotionBuilder, it is converted to centimeters. The FBX Importer accordingly converts the incoming FBX file to match the 3ds Max System units. This now scales your object even though you had no expectation of scaling because your Display units have always been in centimeters.

If you want to exchange FBX files between 3ds Max and MotionBuilder, change your System unit settings to centimeters to match. If you want to exchange FBX files between 3ds Max and Maya, change your 3ds Max System unit settings to match the Maya Working units.

**Revit scaling**

Similar issues occur with Revit as Revit System units are Feet/Meters and 3ds Max System units are inches by default. If you import an FBX file from Revit that uses “Imperial: Feet” as System units into 3ds Max while the 3ds Max default units are inches, the FBX conversion scales all objects in the scene during the import process.

The Revit scale is 12.0 (or 12 inches per foot). This is because, if the scaling did not occur, your units would become one foot = one inch which would then create distortion in any bitmap used in the scene.

For example, if you do not scale objects upon import, a Revit imported house ends up with walls that are 12 inches long, instead of 12 feet long. The FBX conversion scaling is also done to ensure that bitmaps are mapped properly in size in relation to the objects in the scene. If your wall is 12 feet long, it has to be converted to 144 inches long for the bitmap used to display in an appropriate real-world scale.

If you want to exchange FBX files between 3ds Max and Revit, change your System unit settings to feet to match Revit, or you can change the Revit units to match the 3ds Max System units.

**NOTE** We do not recommend that you change the FBX Revit Import preset Units setting in the so that the scale units are feet instead of inches. It is true that if you do this, you create a 1:1 match for objects and avoid any scaling conversion. However, if you change the Revit Preset units setting so that no conversion is performed, all units become non-real-world and then materials do not render at the right scale.

If you want to see the bitmap scaling issue, you can do the following in 3ds Max:

1. Open a new scene in 3ds Max, and create two cubes.
2. Scale one of the cubes by 200%.
3. Apply a standard material with a checkerboard procedural pattern in the diffuse map channel to each cube and make sure that the Real-world Scale option is activated for both the material and primitives.

The checkered map is scaled as well.
Revit workaround

If you do not want to change the 3ds Max default System units, there is another work-around for this scaling problem; manually convert every object to real world scale after you import the file into 3ds Max. If you do this, you must have Inches set as System units, which is the 3ds Max default.

1. Import your FBX file into 3ds Max Design using Inches as System units.
2. Select any of the objects in the scene and verify their scale: 1200%
3. Apply a Standard material with a check pattern in the diffuse map channel to any object in the scene.
4. Create a cube primitive and apply the new material to that object as well. It is apparent that the mapping is not the same scale.
5. In the Material editor, in the Checker Procedural Map coordinates rollout, ensure that real-world scale is active, and adjust the size 48 value to 4 for both Width and Height.

**NOTE** 4 is 48 divided by 12, which compensates for the 1200% scaling.

6. Do this for every object in the scene and the mapping appears identical.
This chapter contains the commands for scripting 3ds Max FBX Plug-ins. The 3ds Max FBX Plug-in must be loaded before you run any script commands with MAXScript, otherwise an error message occurs.

If you use a MAXScript FBX command in the MAXScript listener when the 3ds Max FBX Plug-in is not loaded, commands are ignored even if you load the plug-in afterward.

NOTE When you export or import files in MAXScript, use the command #noPrompt to prevent the FBX Exporter/Importer User Interface from appearing during the process. For example: ImportFile "C:\test.fbx" #noPrompt. If the UI appears before an export or import command executed through MAXScript, the last used preset is chosen, and effectively ignores any recent scripted changes.

Loading the FBX plug-ins

You can load the FBX plug-ins two ways, manually and using MAXScript.

Loading the 3ds Max FBX Plug-in manually

1. Start 3ds Max.
2. Go to the main menu and select Customize > Plug-in Manager.
3. Locate the FBXMAX.DLU name in the list box, right-click it, and choose Selected Plug-ins > Load.

Loading the 3ds Max FBX Plug-in using MAXScript

Run the following scripts to load the FBX plug-ins through MAXScript:

FBX Importer

```
pluginManager.loadClass FBXIMPORTER
```
FBX Exporter

pluginManager.loadClass FBXEXPORTER

NOTE The 3ds Max FBX Plug-in must be loaded before you run any script commands with MAXScript, otherwise an error message occurs.

Scripting commands

Use these script commands to list, query, or set FBX I/O Settings properties for the 3ds Max FBX Plug-in, even properties created with a plug-in extension.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FBXImporterGetParam &quot;FBXProperties&quot;</td>
<td>Use this command to list all the import properties available with path, type, and the specified value.</td>
</tr>
<tr>
<td>FBXExporterGetParam &quot;FBXProperties&quot;</td>
<td>Use this command to list all the export properties available with path, type, and the specified value.</td>
</tr>
<tr>
<td>FBXImporterSetParam &quot;Import\Include-GrpiAnimation\Markers&quot; true</td>
<td>Use this command to set an import value to true.</td>
</tr>
<tr>
<td>FBXExporterSetParam &quot;Export\Include-GrpiLight&quot; true</td>
<td>Use this command to set an export value to true.</td>
</tr>
<tr>
<td>FBXImporterGetParam &quot;Import\Include-GrpiAnimation\Markers&quot;</td>
<td>Use this command to query an import value.</td>
</tr>
<tr>
<td>FBXExporterGetParam &quot;Export\Include-GrpiLight&quot;</td>
<td>Use this command to query an export value.</td>
</tr>
</tbody>
</table>

All script commands and paths in this section are case sensitive, so it is good practice to copy and paste these commands so you have the exact path for the IOSettings when querying for a list of properties and their path.

NOTE These script commands support only Integer, Double, Bool, and Enum properties

FBXExporterGetParam [arg]

The getparam scripts queries the export plug-in parameters where [arg] is a recognized export parameter. FBXExporterGetParam returns the value of the named parameter. If the parameter is unrecognized or the wrong number of arguments are provided, the value “unsupplied” is returned.

For a list of supported parameters, see FBXExporterSetParam [arg] [value] on page 72.

FBXExporterSetParam [arg] [value]

The setparam scripts set the specified argument for export where [arg] is a recognized export parameter and [value] is an appropriate value for the supported parameter. For example, to prevent the export of cameras:

FBXExporterSetParam "Cameras" false
FBXExporterSetParam returns “OK” if successful or “unsupplied” if it is sent an unrecognized parameter.
FBXExporterSetParam returns “unsupplied” if the wrong number of arguments are passed.

FBXExporterSetParam recognizes the following parameter and values:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animation</td>
<td>True or false. See Animation on page 28 for an explanation of this setting.</td>
</tr>
<tr>
<td>ASCII</td>
<td>True or false. See Type on page 38 for an explanation of this setting.</td>
</tr>
<tr>
<td>AxisConversionMethod</td>
<td>“None”, “Animation”, or “Fbx_Root”. See Axis conversion on page 36 for an explanation of this setting.</td>
</tr>
<tr>
<td>BakeAnimation</td>
<td>True or false. See Bake animation on page 28 for an explanation of this setting.</td>
</tr>
<tr>
<td>BakeFrameStart</td>
<td>Integer value. See Bake animation on page 28 for an explanation of this setting.</td>
</tr>
<tr>
<td>BakeFrameEnd</td>
<td>Integer value. See Bake animation on page 28 for an explanation of this setting.</td>
</tr>
<tr>
<td>BakeFrameStep</td>
<td>Integer value. See Bake animation on page 28 for an explanation of this setting.</td>
</tr>
<tr>
<td>Cameras</td>
<td>True or false. See Cameras on page 33 for an explanation of this setting.</td>
</tr>
<tr>
<td>ColladaTriangulate</td>
<td>True or false. See Triangulate on page 40 for an explanation of this setting.</td>
</tr>
<tr>
<td>ColladaSingleMatrix</td>
<td>True or false. See Single matrix on page 40 for an explanation of this setting.</td>
</tr>
<tr>
<td>ColladaFrameRate</td>
<td>Float (in frames). See Triangulate on page 40 for an explanation of this setting.</td>
</tr>
<tr>
<td>Convert2Tiff</td>
<td>True or false. See Convert images to portable format (TIFF) on page 34 for an explanation of this setting.</td>
</tr>
<tr>
<td>ConvertUnit</td>
<td>“mm” or “cm” or “dm” or “m” or “km” or “in” or “ft” or “yd”. See Scene units converted to: on page 35 for an explanation of this setting.</td>
</tr>
<tr>
<td>EmbedTextures</td>
<td>True or false. See Embed media on page 33 for an explanation of this setting.</td>
</tr>
<tr>
<td>FileVersion</td>
<td>“FBX201000” or “FBX200900” or “FBX200611” or “FBX200608” or “FBX200602_MB75” or</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>“FBX200508_MB70” or “FBX60_MB60”. See FBX version on page 38 for an explanation of this setting.</td>
</tr>
<tr>
<td>FilterKeyReducer</td>
<td>True or false. See Constant key reducer on page 29 for an explanation of this setting.</td>
</tr>
<tr>
<td>GeomAsBone</td>
<td>True or false. See Convert deforming dummies to Bones on page 27 for an explanation of this setting.</td>
</tr>
<tr>
<td>GenerateLog</td>
<td>True or False. See Generate log data on page 37 for an explanation of this setting.</td>
</tr>
<tr>
<td>Lights</td>
<td>True or false. See Lights on page 33 for an explanation of this setting.</td>
</tr>
<tr>
<td>LoadExportPresetFile</td>
<td>“x” where x is the name of the preset file. See Export presets on page 22 for an explanation of this setting.</td>
</tr>
<tr>
<td>LoadImportPresetFile</td>
<td>“x” where x is the name of the preset file. See Import presets on page 42 for an explanation of this setting.</td>
</tr>
<tr>
<td>NormalsPerPoly</td>
<td>True or false. See Split per-vertex Normals on page 25 for an explanation of this setting.</td>
</tr>
<tr>
<td>PointCache</td>
<td>True or false. See Point cache file(s) on page 32 for an explanation of this setting.</td>
</tr>
<tr>
<td>Re-evaluateNormals</td>
<td>True or false. See Smoothing groups on page 46 for an explanation of this setting.</td>
</tr>
<tr>
<td>Resampling</td>
<td>Float. See Unroll rotations on page 30 for an explanation of this setting.</td>
</tr>
<tr>
<td>ResetExport</td>
<td>Restores factory defaults.</td>
</tr>
<tr>
<td>ScaleFactor</td>
<td>Float. See Scale Factor on page 35 for an explanation of this setting.</td>
</tr>
<tr>
<td>SelectionSet</td>
<td>Name of the selection set to use. See Point cache file(s) on page 32 for an explanation of this setting.</td>
</tr>
<tr>
<td>Shape</td>
<td>True or false. See “Morphs” in Deformations on page 29 for an explanation of this setting.</td>
</tr>
<tr>
<td>Skin</td>
<td>True or false. See “Skin” in Deformations on page 29 for an explanation of this setting.</td>
</tr>
</tbody>
</table>
For example, to query the export camera’s state:

```plaintext
FBXExporterGetParam "Cameras"
```

### Export selected

A specific MAXscript exists for performing the export of only selected objects ("Export Selected"). Use the following:

```plaintext
exportFile "<path>" #noPrompt selectedOnly:true
```

Where `<path>` is the location to where you want to export your object(s).

---

### FBXImporterGetParam [arg]

The getparam script queries the import plug-in parameters where `[arg]` is a recognized import parameter. FBXImporterGetParam returns the value of the named parameter. If the parameter is unrecognized or the wrong number of arguments are provided, the value “unsupplied” is returned.

For a list of supported parameters, see `FBXImporterSetParam [arg] [value]` on page 75.

---

### FBXImporterSetParam [arg] [value]

The setparam script sets the specified argument for import where `[arg]` is a recognized import parameter and `[value]` is an appropriate value for the supported parameter.

- FBXImporterSetParam returns “OK” if successful or “unsupplied” if it is sent an unrecognized parameter.
- FBXImporterSetParam returns “unsupplied” if the wrong number of arguments are passed.

FBXImporterSetParam recognizes the following parameter and values:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animation</td>
<td>True or false. See <a href="#">Animation</a> for an explanation of this setting.</td>
</tr>
<tr>
<td>AxisConversion</td>
<td>True or false. See <a href="#">Axis conversion</a> for an explanation of this setting.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>BakeAnimationLayers</td>
<td>True or false. See <a href="#">Bake animation layers</a> on page 48 for an explanation of this setting.</td>
</tr>
<tr>
<td>Cameras</td>
<td>True or false. See <a href="#">Cameras</a> on page 52 for an explanation of this setting.</td>
</tr>
<tr>
<td>ConvertUnit</td>
<td>“mm” or “cm” or “dm” or “m” or “km” or “in” or “ft” or “yd”. See <a href="#">File units converted to:</a> on page 54 for an explanation of this setting.</td>
</tr>
<tr>
<td>FillTimeline</td>
<td>True or false. Activate this option when you want to update the application Timeline by the animation range in the incoming FBX file. “Animation range” refers to the first and last keys of animation contained in the file.</td>
</tr>
<tr>
<td>FilterKeyReducer</td>
<td>True or false. See <a href="#">Constant key reducer</a> on page 49 for an explanation of this setting.</td>
</tr>
<tr>
<td>FilterKeySync</td>
<td>True or false. See <a href="#">Key Reducer</a> on page 50 for an explanation of this setting.</td>
</tr>
<tr>
<td>GenerateLog</td>
<td>True or False. See <a href="#">Generate log data</a> on page 56 for an explanation of this setting.</td>
</tr>
<tr>
<td>ImportBoneAsDummy</td>
<td>True or false. See <a href="#">Bones</a> on page 51 for an explanation of this setting.</td>
</tr>
<tr>
<td>KeepFrameRate</td>
<td>True or false.</td>
</tr>
<tr>
<td>Lights</td>
<td>True or false. See <a href="#">Lights</a> on page 52 for an explanation of this setting.</td>
</tr>
<tr>
<td>LoadImportPresetFile</td>
<td>“x” where x is the location of the preset file. See <a href="#">Import presets</a> on page 42 for an explanation of this setting.</td>
</tr>
<tr>
<td>Markers</td>
<td>True or false. See <a href="#">Optical markers</a> on page 48 for an explanation of this setting.</td>
</tr>
<tr>
<td>Mode</td>
<td>#create (Add to scene)#exmerge (Update scene elements)#merge (Add and Update scene elements). See <a href="#">File content</a> on page 52 for an explanation of this setting.</td>
</tr>
<tr>
<td>PointCache</td>
<td>True or false. See <a href="#">Point cache file(s)</a> on page 51 for an explanation of this setting.</td>
</tr>
<tr>
<td>Resampling</td>
<td>Float.</td>
</tr>
<tr>
<td>ResetImport</td>
<td>Restores factory defaults.</td>
</tr>
<tr>
<td>Name</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>ScaleConversion</td>
<td>True or false. See <a href="#">Units</a> on page 53 for an explanation of this setting.</td>
</tr>
<tr>
<td>ScaleFactor</td>
<td>Float. See <a href="#">Scale Factor</a> on page 53 for an explanation of this setting.</td>
</tr>
<tr>
<td>Shape</td>
<td>True or false. See <a href="#">Deformations</a> on page 47 for an explanation of this setting.</td>
</tr>
<tr>
<td>Skin</td>
<td>True or false. See <a href="#">Deformations</a> on page 47 for an explanation of this setting.</td>
</tr>
<tr>
<td>SmoothingGroups</td>
<td>True or false. See <a href="#">Smoothing groups</a> on page 46 for an explanation of this setting.</td>
</tr>
<tr>
<td>TakeCount</td>
<td>This parameter is only available for the “get” function.</td>
</tr>
<tr>
<td>TakeIndex</td>
<td>An integer number from 1 to the number of takes in the FBX file. This parameter is only available for setting. See <a href="#">Animation Take</a> on page 48 for an explanation of this setting.</td>
</tr>
<tr>
<td>UpAxis</td>
<td>“Y” or “Z”. See <a href="#">Axis conversion</a> on page 55 for an explanation of this setting.</td>
</tr>
</tbody>
</table>

For example, to import an FBX file using the Add and Update scene elements mode and the skin modifier, but without loading animation FCurves:

```c
FBXImporterSetParam "Mode" "merge"
FBXImporterSetParam "Skin" true
FBXImporterSetParam "Animation" false
```
.fbm folder The folder generated when you export an FBX file with the Embed Media option activated. The FBM folder contains all the associated textures in the FBX file. The “M” in FBM is for “Media”. See Embed media on page 33.

.mc file Autodesk point cache file extension.

.pc2 file Legacy 3ds Max point cache file extension.

.xml file Extensible Markup language file. The 3ds Max FBX Plug-in creates an XML file when it processes Autodesk point cache data.

ASCII Stands for American Standard Code for Information Interchange.

bake Baking is a re-sampling of the animation data within your scenes.

Bind pose (Maya) In animation, the default position of a skeleton, used to keep track of transformation attributes for all the skeleton’s joints and influence objects.

bone Bones are 3D objects that you can link like human joints to create animation.

curve See FCurve on page 79.

Degrees of Freedom (DOF) Degrees of Freedom (DOF) are MotionBuilder properties that let you limit translation, rotation, and scaling of objects or animated hierarchies. Defining Degrees of Freedom for objects in a scene lets you restrict their range of movement.

destination application The application in which you want to use your FBX file.

dummy A type of 3ds Max helper object, a placeholder.

dummy An edge is a straight or curved line that connects two vertices in a mesh object or spline. You can modify object shapes by transforming its edges.

Euler In animation, a method of rotation that uses three angle values (X, Y and Z) plus a rotation order to specify three-dimensional orientation. Euler rotation has several drawbacks, including Gimbal lock on page 80 and choppy interpolation between keyframes.

FBX file An Autodesk FBX format file used as a universal 3D Asset Exchange.

FCurve (MotionBuilder) (Also referred to as a Function Curve.) A graphic depiction of an animated value. The time and value of the animated value displays on two axes: the vertical axis representing the value, and the horizontal axis representing the time.
fps Frames per second.

genomey (Maya) In general, a surface, NURBS on page 80, NURBS curve, subdivision surface, or polygonal surface (mesh).
(3ds Max) Geometry refers to all objects that are not cameras or lights. Meshes, polys, patches, NURBS, splines, helper objects, etc.

Geometry cache A file that stores positions of vertices. Cache files let you preview the results of a simulation without rendering the scene.

Gimbal lock A Gimbal Lock occurs when you rotate one axis and accidentally align the two other axes. When these two axes align, you lose one axis because you cannot separate them. When a gimbal lock occurs, your bone can rotate only in two axes instead of all three.

host application The application used to create the file you are going to save as an FBX file.

key A reference point, or key point, that marks the position of an important action or change in a scene at a specific point in time.

mesh In polygonal modeling, a collection of polygons, which can be of different types (triangles, quads, n-sided).

morpbf Morph is a method of 3D computer animation that is sometimes used as an alternative to skeletal animation. Morph target animation is stored as a series of vertex positions. In each keyframe of the animation, the vertices are moved to a different position. Depending on the renderer, vertices move along paths to fill the empty time between keyframes. The renderer can also switch between different positions. Animation composed in one 3D application suite may require transfer to another, such as for rendering. To avoid export issues, native animation formats often convert to morph target animation. This is necessary to accommodate the implementation of bones and other special effects in different 3D application suites.

normal In modeling, the directional line perpendicular to a surface. Polygon normals indicate the orientation of polygonal faces. Because shaded (or rendered) faces are visible only when the normals are facing towards the viewer, it is sometimes necessary to reverse a normal to correct a face’s orientation.

NURBS Non-Uniform Rational B-Spline. A type of geometry that includes curves, patches, surfaces, etc. NURBS are a superset of conics, splines, and Bezier curves. They are particularly suited for modeling in 3D, because they provide excellent continuity with a minimum number of control points.

NURMS Non-Uniform Rational MeshSmooth. A NURMS object is similar to a NURBS object in that you can set different weights for each control vertex.

Point cache (3ds Max) A file (or series of files) that stores positions of vertices. Cache files let you preview the results of a simulation without rendering the scene.

polygons An n-sided shape defined by a group of ordered vertices and the edges that are defined between pairs of those vertices. Polygons can be either simple shapes, such as polygonal primitives, or complex models built from the various polygonal tools. A polygonal object can be closed, open, or made up of shells, which are disjointed pieces of geometry. Also known as mesh.

procedural image map An image not composed of a fixed matrix of colors, but rather generated procedurally by a mathematical algorithm. You cannot transfer these textures through the FBX format.

Quaternion interpolation A method of rotation that uses a unit quaternion (a quaternion of length one) to represent an orientation in three dimensions. A quaternion is a four dimensional extension to complex numbers. Quaternion rotation is an option that is useful for avoiding Gimbal lock on page 80.

resample The process of creating a key for every nth frame of an animation’s interpolation (or curve).

selection set (3ds Max) A group of objects that have a name assigned to them.

skin A deformation tool that lets one object deform another, for example a skeleton deforms a mesh.
**smoothing groups** Smoothing groups define whether a surface is rendered with hard edges or soft surfaces. Smoothing groups are numbers assigned to the faces or patches of an object. Each face or patch can carry a maximum of 32 smoothing groups. If two faces or patches share an edge and share the same smoothing group, they render as a smooth surface. If they do not share the same smoothing group, the edge between them renders as a corner.

**take** (MotionBuilder) An animation scene done between one start and the following stop, a segment.

**triangles** Objects in 3D scenes are composed of triangles. The triangles are defined as three XYZ vertex coordinates.

**UI** User interface.

**up-axis** The up axis is the global axis that is pointing upwards. (Maya) There are two choices of axis (Y or Z) as the world up direction. The Y axis is used as the default up axis. (3ds Max) The Z axis is used as the world up axis. This cannot be changed.

**Y-axis** Maya’s default up-axis.

**Z-axis** 3ds Max’s default up-axis.
Index

3ds Max Design
   importing  60

A

add and update scene elements  52
advanced options
   axis conversion (import)  55
   FBX file format (export)  38
   file units conversion (import)  54
   scale factor (import)  53
   section (export)  35
   section (import)  53
   UI (export)  37
   UI (import)  56
   units (export)  35
   units (import)  53
animation
   animation take (import)  48
   bake animation (export)  28
   bones (import)  51
   curve filters (export)  29
   curve filters (import)  48
   deformations (export)  29
   deformations (import)  47
   optical markers (import)  48
   point cache file(s) (export)  32
   point cache file(s) (import)  51
   Autodesk Architectural (Revit) preset (import)  43
   Autodesk Media & Entertainment preset (import)  43
   automatic axis conversion
   purpose  56
B

bake animation (export)  28
bakes animation
   exporting layers  5
biped layers  5
C

camera
   workflow limitations  63
camera support
   camera export  7
   camera import  7
cameras
   Flame  64
   IFFFS import and export  64
cancel button  17
Collada
   export  39
   conversion
      large file sizes  60
   conversion support  6
      camera support  6
      light support  7
   convert deforming dummies to bones (export)  27
   copyright  ii
   curve filters  29
      constant key reducer (export)  29
      constant key reducer (import)  49
      key reducer (export)  31
      key reducer (import)  50
      unroll rotations (export)  30
D

DAE
   export  39
display layers (import)  47
E

differences
   preserving turned edges  65
   removing visible  61
edit  16
   creating a custom preset  17
   edit mode options  18
   editing a preset  17
   preset  23
   edit mode
      view as expandable group/view as expanded panel  19
   edit mode options
      enable/disable  19
      expand/collapse  19
      show/hide  18
   edit/save preset  24
   edit/save preset (import)  44
   editing a preset  43
   embed media
      convert to TIFF (export)  34
   error
      difference between error and warning  37
      difference from warnings  56
Index

example 65
  file unit conversion 54
export 21
  Collada DAE 39
  Flame to FBX 64
  IFFFS cameras 64
  multi-layer animation 5
  selected (MaxScript) 75

export preset
  Autodesk Media & Entertainment preset 23
export presets 22
  edit/save preset 24
exporting
  to FBX from Revit Architecture 59
exporting from 3ds Max to an FBX file 21

F

fbxexportergetparam 72
fbxexportersetparam 72
fbximportergetparam 75
fbximportersetparam 75
faceted geometry
  importing in Revit 60
  FBX file type (export) 38
  FBX file version (export) 38
  fbx plug-in UI 15
  File content 52
  file units conversion
    example 54
Flame
  import/export of cameras 64
Flame cameras
  export a camera 64

G

generate log data
  why 37, 56
generate log data (export) 37, 56
geometry
  convert deforming dummies to bones (export) 27
  importing faceted 60
  smoothing groups (import) 46
  split per-vertex normals (export) 25
  workflow limitations 63
groups
  workflow limitations 63

H

hard edges
  work around 25
help 15
how to
  check version number 14
  create custom presets 17
  edit a preset 43
  export from Revit Architecture 59
export to FBX 21
import FBX files into 3ds Max 41
import/export Flame cameras 64
select a preset 42
how-to 65
import to 3ds Max Design 60

I

IFFFS
  flame cameras 64
  importing and exporting cameras 64
import 41
  display layers 47
  FBX files into 3ds Max 41
  IFFFS cameras 64
  presets 42
  smoothing groups 46
importing
  FBX file into 3ds Max Design 60
  file content 52
include
  animation (export) 28
  animation (import) 47
  cameras (export) 33
  cameras (import) 52
  embed media (export) 33
  geometry (export) 25
  geometry (import) 46
  lights (export) 33
  lights (import) 52
include (export) 24
include (import) 46
installation 11
  checking your FBX version number 14
  downloading the 3ds Max FBX plug-in 14
  Windows installation 11
installing the 3ds Max FBX plug-in 11

K

known limitations
  bitmaps, procedural, and map channels 6
  scale compensation 5
known limitations for this version 4

L

large file size on conversion
  cause 60
large file sizes 60
limitations
  Revit daylight portals 64
  Revit project units 64
  workflow 63
log file
  location 37, 56
M
Maya
  scaling issues 67
MotionBuilder
  scaling issues 67
multi-layer animation (export) 5

O
ok button 17

P
performance
  improve 63
polygon conversion
  notes 67
preserving turned edges 65
  cause 65
  workaround 66
preset
  editing 23
  selecting 22
presets
  export 22
  import 42

R
re-evaluate smoothing groups
  when to use 47
Revit
  Daylight portal limitations 64
  export how-to 59
  group limitations 63
  hidden elements 63
  importing faceted geometry 60
  large file size 60
  project unit limitations 64
  scaling issues 68
Revit Architecture to 3ds Max workflow 59

S
scale compensation 5
  deactivation 6
    when to de-activate it so it imports correctly into 3ds max 6
scale conversion
  example 36
scaling
  unwanted 67
scripting
  export selected 75
scripting for the 3ds max fbx plug-in 71
select
  preset 22
selecting a preset 42
show/hide warning manager 37
smoothing groups
  example 47
split per-vertex workflow 25
statistics (import) 44
statistics window
  file axis direction (import) 45
  file content (import) 45
  file creation time (import) 45
  file creator (import) 45
  file directory (import) 45
  file name (import) 45
  file units (import) 45
  file version (import) 45
  system axis direction (import) 45
  system units (import) 45

T
take
  Use scene name option 28
tips 59
TurboSmooth 26
turned edges
  cause 65
  how to preserve 65
  preserving 65

U
ui
  show/hide warning manager (export) 37
  show/hide warning manager (import) 56
UI 15
units
  axis conversion (export) 36
  scale factor (export) 35
  scene units conversion (export) 35
unwanted scaling 67
update plug-in 15
Use scene name (export) 28

V
visible edges
  removing 61

W
warning
  difference between error and warning 37
  difference from errors 56
warnings
  show/hide 56
warnings and errors
  generate log data (export) 37, 56
web updates 15
### what's new

- Windows installation
  - Windows compatibility
  - work around
    - hard edge issues
  - workaround
    - preserving turned edges

- removing visible edges
- workflow limitations
- cameras
- daylight portals
- geometry
- hidden Revit elements
- performance
- project units
- Revit groups
- workflows